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Κεφάλαιο 1ο – Εισαγωγή 

 

1.1 Εισαγωγικά στοιχεία 

Είναι κοινά αποδεκτό, ότι η έγκαιρη και σωστή ανάδραση παίζει σπουδαίο ρόλο 

στην επιτυχία ενός έργου, αφού συντελεί στον άµεσο εντοπισµό των προβληµάτων και στη 

λήψη των απαραίτητων διορθωτικών µέτρων. Η µέθοδος της «∆εδουλευµένης Αξίας» έχει 

αποδειχθεί ως η πλέον αξιόπιστη µέθοδος για την αποτελεσµατική διοίκηση ενός έργου. Η 

µέθοδος εµφανίστηκε για πρώτη φορά ως εργαλείο διοίκησης έργων από το Υπουργείο 

Εθνικής Άµυνας της Αµερικής τη δεκαετία του 1960. Αρχικά, οδηγήθηκε σε απαξίωση 

λόγω των πολλών αρκτικόλεξων που χρησιµοποιούσε και ορισµένων λογιστικών γνώσεων 

που απαιτούσε, αργότερα όµως αποδείχτηκε πολύ αποτελεσµατική και αξιόπιστη οπότε και 

εξαπλώθηκε σηµαντικά. 

Η µέθοδος της «∆εδουλευµένης Αξίας» βασίζεται στη σύγκριση του πραγµατικού 

κόστους ενός έργου, µε το προϋπολογισθέν κόστος αυτού και µε την αξία του έργου που 

έχει ήδη ολοκληρωθεί και πιστωθεί σ’ αυτό. Ο όρος «∆εδουλευµένη Αξία» προέρχεται από 

το γεγονός ότι κάθε παραδοτέο του έργου έχει ένα προϋπολογισθέν κόστος, η αξία του 

οποίου «αποκτάται» από το έργο, µόλις το παραδοτέο ολοκληρωθεί.  

Για την εφαρµογή της µεθόδου απαιτούνται τα εξής τρία βήµατα: 

• Αναγνώριση των παραδοτέων του έργου 

• Ανάπτυξη ενός χρονοδιαγράµµατος για την ολοκλήρωση των παραδοτέων 

• Αντιστοίχιση ενός κόστους (αξίας) για κάθε παραδοτέο 

Με άλλα λόγια, το έργο, το χρονοδιάγραµµα του έργου και το κόστος αυτού, θα 

πρέπει να έχουν καθοριστεί εξαρχής.  
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Η µέθοδος δύναται να δώσει απαντήσεις σε όλα τα κρίσιµα ερωτήµατα που 

απασχολούν τη διοίκηση όπως: 

• Που βρίσκεται το έργο σε σχέση µε το συµφωνηθέν χρονοδιάγραµµα; 

• Πόσο αποτελεσµατικά χρησιµοποιείται ο διαθέσιµος χρόνος του έργου; 

• Πότε πρόκειται να ολοκληρωθεί το έργο; 

• Πόσο υπερκοστολογηµένο ή µη είναι το έργο σε σχέση µε το συµφωνηθέν 

προϋπολογισθέν κόστος; 

• Πόσο αποτελεσµατικά χρησιµοποιούνται οι διαθέσιµοι πόροι του έργου 

• Πόσο θα κοστίσει η εργασία που αποµένει για την ολοκλήρωση του έργου 

• Ποιο θα είναι το ολικό κόστος του έργου 

Στην περίπτωση όπου η εφαρµογή της µεθόδου της «∆εδουλευµένης Αξίας» σε ένα 

έργο αποκαλύψει ότι το έργο βρίσκεται πίσω από το χρονοδιάγραµµα ή πάνω από τον 

αρχικό προϋπολογισµό, η ίδια η µέθοδος µπορεί να δώσει απαντήσεις στα εξής: 

• Που εντοπίζονται τα προβλήµατα; 

• Πόσο κρίσιµα ή µη είναι τα προβλήµατα που αποκαλύφθηκαν; 

• Τι απαιτείται να διορθωθεί ώστε το έργο να έρθει και πάλι σε ισορροπία; 

 

1.2 Η εφαρµογή της µεθόδου της «∆εδουλευµένης Αξίας» στις φάσεις διοίκησης 

ενός έργου 

Η διοίκηση έργου αποτελεί πρωταρχικά ένα ζήτηµα σχεδιασµού, εκτέλεσης και 

ελέγχου της εργασίας που απαιτείται να πραγµατοποιηθεί. Η µέθοδος της ∆εδουλευµένης 

Αξίας βρίσκει εφαρµογή και στις τρεις αυτές σηµαντικές φάσεις της διοίκησης έργων, 

όπως φαίνεται και στον πίνακα που ακολουθεί. 
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Φάσεις ∆ιοίκησης Έργων 
Τοµείς 

Έναρξη Σχεδιασµός Εκτέλεση Έλεγχος Κλείσιµο 

Ολοκλήρωση  Χ Χ Χ  
Αντικείµενο  Χ  Χ  
Χρόνος  Χ  Χ  
Κόστος  Χ  Χ  
Ποιότητα      
Ανθρ. Πόροι      
Επικοινωνία  Χ Χ Χ  
Κίνδυνοι  Χ  Χ  
Προµήθεια  Χ  Χ  

Πίνακας 1 – Φάσεις διοίκησης έργων και µέθοδος «∆εδουλευµένης Αξίας» 

 

Ως µέθοδος µέτρησης της αποτελεσµατικότητας ενός έργου, η µέθοδος της 

«∆εδουλευµένης Αξίας» σχετίζεται µε διαδικασίες µέτρησης, ανάλυσης, πρόβλεψης και 

αναφοράς των δεδοµένων του κόστους και του χρονοδιαγράµµατος ενός έργου.  

Κατά τη διάρκεια του σχεδιασµού ενός έργου, η µέθοδος της «∆εδουλευµένης 

Αξίας» απαιτεί τη θέσπιση της βάσης µέτρησης της αποτελεσµατικότητας γνωστή µε τον 

όρο Performance Measurement Baseline (PMB). Για τον υπολογισµό αυτής, απαιτείται η 

κατάτµηση του έργου σε επιµέρους δραστηριότητες που καλούνται σηµεία ελέγχου 

(control accounts). Η εκτέλεση και παρακολούθηση κάθε επιµέρους δραστηριότητας θα 

πρέπει να αντιστοιχηθεί σε ένα η περισσότερα άτοµα όπως απεικονίζεται στο ακόλουθο 

διάγραµµα. 
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Πίνακας 2 – Μήτρα σηµείων ελέγχου 

 

Στη φάση της εκτέλεσης, η µέθοδος της «∆εδουλευµένης Αξίας», απαιτεί την 

καταγραφή των χρησιµοποιούµενων πόρων (υλικά, εργατικά, κλπ) για την εργασία που 

έχει ολοκληρωθεί. Με άλλα λόγια, στη φάση της εκτέλεσης, τα πραγµατικά κόστη 

καταγράφονται κατά τέτοιο τρόπο που να είναι δυνατή η σύγκρισή τους µε τα αντίστοιχα 

κόστη που πηγάζουν από τη βάση µέτρησης της αποτελεσµατικότητας (Performance 

Measurement Baseline). 

Στη φάση του ελέγχου, η µέθοδος της «∆εδουλευµένης Αξίας» απαιτεί την 

αξιολόγηση της παραγόµενης εργασίας και την πίστωση της µε την αξία που της αναλογεί. 

Η ανωτέρω «∆εδουλευµένη Αξία» σε συνδυασµό µε την προϋπολογισθείσα αξία 

που προέρχεται από τη βάση µέτρησης της αποτελεσµατικότητας (PMB) και µε το 

πραγµατικό κόστος που προέρχεται από την καταγραφή των πόρων που έχουν αναλωθεί, 

παρέχουν στην οµάδα διοίκησης του έργου όλα τα απαραίτητα εφόδια για την επιτυχή 

εφαρµογή της µεθόδου της «∆εδουλευµένης Αξίας».  

WBS

O
BS

WBS = Work 
Breakdown 
Structure
OBS = 

Organization 
Breakdown 
Structure

Control 
Accounts
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Συνοψίζοντας τα ανωτέρω, η διοίκηση έργων µε τη µέθοδο της «∆εδουλευµένης 

Αξίας», συντελεί σε αποτελεσµατικό και αποδοτικό σχεδιασµό και έλεγχο του κόστους και 

του χρονοδιαγράµµατος του έργου, χρησιµοποιώντας τις δύο ακόλουθες πρακτικές: 

• ∆ηµιουργία της βάσης µέτρησης της αποδοτικότητας του έργου (PMB) 

o Κατάτµηση του αντικειµένου του έργου σε επιµέρους δραστηριότητες. 

o Αντιστοίχιση δραστηριοτήτων σε έναν ή περισσότερους υπεύθυνους. 

o Αντιστοίχιση ενός κόστους (αξία) σε κάθε επιµέρους δραστηριότητα. 

• Μέτρηση και ανάλυση της απόδοσης του έργου σύµφωνα µε τη θεσπισµένη 

βάση µέτρησης της αποδοτικότητας (PMB) 

o Κατάτµηση του αντικειµένου του έργου σε επιµέρους δραστηριότητες. 

o Αντικειµενική αξιολόγηση της πορείας του έργου. 

o Πίστωση κάθε επιµέρους δραστηριότητας που έχει ολοκληρωθεί µε τη 

«∆εδουλευµένη Αξία» που της αναλογεί. 

o Ανάλυση και πρόβλεψη του κόστους και χρονοδιαγράµµατος του έργου. 

o Αναφορά της απόδοσης του έργου και ανάληψη διορθωτικών µέτρων όπου 

απαιτείται. 
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Κεφάλαιο 2ο – Βασικά στοιχεία µεθόδου «∆εδουλευµένης Αξίας» 

 

2.1 Βασικά στοιχεία µεθόδου «∆εδουλευµένης Αξίας» 

Όπως αναφέρθηκε συνοπτικά ανωτέρω, η µέθοδος της «∆εδουλευµένης Αξίας» 

βασίζεται σε τρία βασικά στοιχεία. Στο κεφάλαιο αυτό επιχειρείται η ανάλυση κάθε ενός 

από αυτά καθώς και ο τρόπος µε τον οποίο εξάγονται. Για την καλύτερη κατανόηση των 

εννοιών της µεθόδου θα χρησιµοποιηθεί ένα τυχαίο παράδειγµα ανακατασκευής ενός 

παλαιού δώµατος µιας οικίας. Το παράδειγµα αυτό είναι εντελώς υποθετικό αλλά µπορεί 

να αναπαραστήσει οποιοδήποτε έργο όπως , την κατασκευή ενός πολυώροφου κτιρίου, την 

ανάπτυξη ενός νέου λογισµικού ή την κατασκευή ενός αεροσκάφους. Οι θεµελιώδεις αρχές 

της µεθόδου της «∆εδουλευµένης Αξίας» είναι οι ίδιες άσχετα µε τον τύπο ή το µέγεθος 

του έργου.  

Έστω λοιπόν ότι πρόκειται να ανακατασκευάσουµε το παλαιό δώµα ενός διώροφου 

σπιτιού που εκτείνεται τρία µέτρα πάνω από το έδαφος και έχει συνολικό εµβαδόν δέκα 

τετραγωνικά µέτρα. Η όλη κατασκευή θα συνδεθεί µε το υπόλοιπο δοµικό πλαίσιο του 

σπιτιού και θα υποστηριχθεί από τέσσερα θεµέλια τσιµέντου. Ο πίνακας που ακολουθεί 

περιλαµβάνει τις δραστηριότητες που συνθέτουν το έργο καθώς και τις ώρες που 

απαιτούνται για την ολοκλήρωση κάθε µιας από αυτές. 

 

A/A ∆ραστηριότητα 
Προϋπολογισθέν 

Κόστος         
( Ώρες ) 

Προγραµµατισµένη 
∆ιάρκεια            
( Ηµέρες ) 

Προγραµµατισµένη 
Ηµεροµηνία Λήξης   

( Ηµέρες ) 

1 Κατασκευή σχεδίων και 
κατάρτιση λίστας υλικών 6 1 Ηµέρα 1 

2 Αποξήλωση παλαιού 
δώµατος 12 1 Ηµέρα 2 

3 Αποµάκρυνση παλαιών 
υλικών 4 0,5 Ηµέρα 3 
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4 Προµήθεια υλικών 4 0,5 Ηµέρα 3 

5 Εκσκαφή λάκκων 
θεµελίων 8 2 Ηµέρα 5 

6 
Έκχυση τσιµέντου για 
την κατασκευή των 
θεµελίων 

4 1 Ηµέρα 6 

7 Κατασκευή δώµατος 12 3 Ηµέρα 9 

8 Κατασκευή σκάλας 
ανόδου 8 2 Ηµέρα 11 

9 Καθαρισµός χώρου 6 1 Ηµέρα 12 

 Total 64 Ώρες 12 Ηµέρες  

Πίνακας 3 – Προϋπολογισθέν κόστος ανακατασκευής δώµατος 

 

Όπως φαίνεται από τη δεύτερη στήλη του πίνακα, ως µέσο αποτίµησης των 

δραστηριοτήτων του έργου χρησιµοποιήθηκε η ώρα, γεγονός πολύ συχνό στο χώρο της 

διοίκησης έργων, αφού συµβάλλει σε άµεση και αντικειµενική αποτίµηση των εργασιών. 

 

2.2 Προϋπολογισθέν Κόστος (Planned Value)  

Με τον όρο Προϋπολογισθέν Κόστος (Planned Value) ορίζεται το ποσό των 

χρηµάτων που έχει προϋπολογισθεί να γίνει όλη η εργασία µέχρι την ηµεροµηνία της 

ανάλυσης. Με άλλα λόγια αντιπροσωπεύει το πλάνο που πρέπει να ακολουθηθεί για την 

περάτωση του έργου και απαντά στο ερώτηµα πόση εργασία θα έπρεπε αν έχει εκτελεσθεί. 

Το προϋπολογισθέν κόστος είναι γνωστό µε τον αγγλικό όρο Budgeted Cost of Work 

Scheduled (BCWS) ή Performance Measurement Baseline (PMB). Για τον υπολογισµό του 

BCWS αρκεί να αθροίσουµε το προϋπολογισθέν κόστος κάθε επιµέρους δραστηριότητας 

που συνθέτει το έργο µέχρι την ηµεροµηνία ολοκλήρωσής του. Για το παράδειγµα που 

µελετάµε, η γραφική παράσταση του BCWS έχει ως εξής: 
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Γραφική Παράσταση BCWS
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Πίνακας 4 – Γραφική παράσταση BCWS 

 

Αφού ολοκληρώσαµε τον αρχικό σχεδιασµό και υπολογίσαµε τη βάση µέτρησης 

της αποτελεσµατικότητας (PMB), µπορούµε να προχωρήσουµε στην παρακολούθηση του 

έργου και να διαπιστώσουµε την εξέλιξή του. Ο πίνακας που ακολουθεί, απεικονίζει την 

κατάσταση του έργου µετά από πέντε ηµέρες. Συγκεκριµένα, απεικονίζει τις πραγµατικές 

ώρες που έχουν δαπανηθεί και την κατάσταση κάθε επιµέρους δραστηριότητας. Μόνο όταν 

έχει ολοκληρωθεί πλήρως η δραστηριότητα, η αξία της «αποκτάται» από το έργο. 

Σύµφωνα λοιπόν µε το χρονοδιάγραµµα, είχαµε υπολογίσει να δαπανήσουµε 34 

ώρες για την πλήρη περάτωση των πέντε πρώτων δραστηριοτήτων του έργου. Στην 

πραγµατικότητα όµως, δαπανήθηκαν 36 ώρες και ολοκληρώθηκαν πλήρως οι τέσσερις 

πρώτες δραστηριότητες. Η πέµπτη δραστηριότητα «εκσκαφή λάκκων θεµελίων» έχει 

αρχίσει ήδη αλλά έχει ξεπεράσει τον αρχικό σχεδιασµό και δεν έχει ολοκληρωθεί πλήρως. 
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Ως εκ τούτου, καµιά αξία δεν µπορεί να πιστωθεί στο έργο από την συγκεκριµένη 

δραστηριότητα. 

Α/A ∆ραστηριότητα 
Προϋπολογισθέν 

Κόστος 
( Ώρες ) 

Πραγµατικό 
Κόστος        ( 

Ώρες ) 

Κατάσταση 
∆ραστηριότητας 

∆εδουλευµένη 
Αξία           

( Ώρες ) 

1 Κατασκευή σχεδίων και 
κατάρτιση λίστας υλικών 6 6 Ολοκληρώθηκε 6 

2 Αποξήλωση παλαιού 
δώµατος 12 12 Ολοκληρώθηκε 12 

3 Αποµάκρυνση παλαιών 
υλικών 4 4 Ολοκληρώθηκε 4 

4 Προµήθεια υλικών 4 4 Ολοκληρώθηκε 4 

5 Εκσκαφή λάκκων θεµελίων 8 10 Ξεκίνησε 0 

Σηµείο Ανάλυσης (Σύνολα) 34 36 - 26 

Πίνακας 5 – Πορεία έργου 

 

2.3 ∆εδουλευµένη Αξία (Earned Value)  

∆εδουλευµένη Αξία (Earned Value) για την περατωµένη εργασία µέχρι την 

ηµεροµηνία της ανάλυσης, ορίζεται το κόστος που αρχικά είχε προϋπολογισθεί για να 

ολοκληρωθεί η εν λόγω εργασία. Η ∆εδουλευµένη Αξία είναι γνωστή µε τον αγγλικό όρο 

Budgeted Cost of Work Performed (BCWP) και απαντά στο ερώτηµα πόση εργασία έχει 

εκτελεσθεί. Για τον υπολογισµό του BCWP αρκεί να αθροίσουµε τη «∆εδουλευµένη Αξία» 

κάθε επιµέρους δραστηριότητας που έχει ολοκληρωθεί µέχρι την ηµεροµηνία ανάλυσης. 

Για το παράδειγµα που µελετάµε, η γραφική παράσταση του BCWP έχει ως εξής: 
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Πίνακας 6 – Γραφική παράσταση BCWP 

 

2.4 Πραγµατικό Κόστος (Actual Cost)  

Το Πραγµατικό Κόστος, που είναι γνωστό και µε τον αγγλικό όρο Actual Cost of 

Work Performed (ACWP), αποτελεί την ένδειξη του συνόλου των πόρων που έχουν 

αναλωθεί για την ολοκλήρωση των εργασιών µέχρι την ηµεροµηνία της ανάλυσης. Με 

άλλα λόγια, είναι το ποσό των χρηµάτων που στοίχισε πραγµατικά η εργασία που 

εκτελέστηκε πραγµατικά. Για τον υπολογισµό του ACWP αρκεί να αθροίσουµε το 

πραγµατικό κόστος κάθε επιµέρους δραστηριότητας που έχει ολοκληρωθεί ή βρίσκεται σε 

εξέλιξη, µέχρι την ηµεροµηνία της ανάλυσης. Για τον σωστό καθορισµό του Πραγµατικού 

Κόστους ενός έργου, θα πρέπει να είναι σε εφαρµογή από τη διοίκηση, ένα σύστηµα 

εντοπισµού του κόστους (cost tracking system) κάθε επιµέρους δραστηριότητας που 

συνθέτει το έργου. Η φιλοσοφία και η πολυπλοκότητα του συστήµατος µπορεί να ποικίλλει 
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Γραφική Παράσταση ACWP
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ανάλογα µε το αντικείµενο και το µέγεθος του έργου. Για το παράδειγµα που µελετάµε, η 

γραφική παράσταση του ACWP έχει ως εξής: 

 

 

 

 

 

 

 

 

 

 Πίνακας 7 – Γραφική παράσταση ACWP 

 

Για να αξιολογήσουµε την πορεία του έργου µέχρι την ηµεροµηνία ανάλυσης, 

απεικονίζουµε τις γραφικές παραστάσεις του προϋπολογισθέν κόστους (planned cost), του 

πραγµατικού κόστους (actual cost) και της δεδουλευµένης αξίας (earned value) του έργου 

σε ένα γράφηµα.  

Μελετώντας το συγκεντρωτικό γράφηµα, παρατηρούµε ότι µέχρι την τρίτη ηµέρα 

του έργου, η γραµµή του πραγµατικού κόστους (πράσινο) συµπίπτει µε τη γραµµή του 

προϋπολογισθέν κόστους (κόκκινο). Αυτό συνεπάγεται ότι τα πραγµατικά κόστη µέχρι την 

τρίτη ηµέρα συµβάδιζαν µε τον αρχικό προγραµµατισµό. Μετά την τέταρτη ηµέρα όµως, 

παρατηρούµε ότι αφενός το πραγµατικό κόστος υπερβαίνει το προϋπολογισθέν αφετέρου η 

δεδουλευµένη αξία βαίνει µειούµενη σε σχέση µε το προγραµµατισµό. 
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Συγκεντρωτική Γραφική Παράσταση Έργου
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Πίνακας 8 – Συγκεντρωτική Γραφική Παράσταση Έργου 
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Κεφάλαιο 3ο – Ανάλυση απόδοσης και πρόβλεψη έκβασης έργου µε βάση 

τη µέθοδο της «∆εδουλευµένης Αξίας» 

 

3.1 Τα παραγόµενα µεγέθη της µεθόδου της «∆εδουλευµένης Αξίας» 

Στο κεφάλαιο που ακολουθεί, εξετάζεται ο τρόπος µε τον οποίο τα τρία βασικά 

στοιχεία της µεθόδου της «∆εδουλευµένης Αξίας» συνδυάζονται µεταξύ τους, για να 

καταστεί δυνατή η ανάλυση της τρέχουσας πορείας του έργου και να προβλεφθεί η τελική 

του έκβαση.  Στο σηµείο αυτό, θα πρέπει να αναφερθεί ένα επίσης βασικό στοιχείο της 

µεθόδου της «∆εδουλευµένης Αξίας», γνωστό µε τον όρο Budget At Completion (BAC). 

Το BAC είναι το ολικό προϋπολογιστικό κόστος του έργου και συµπίπτει µε το Budget 

Cost of Work Scheduled (BCWS) κατά την ολοκλήρωση. 

Τα παραγόµενα µεγέθη της µεθόδου της «∆εδουλευµένης Αξίας» µπορούν να 

οµαδοποιηθούν στις εξής τρεις κατηγορίες: 

• ∆ιακυµάνσεις (Variances): Στην κατηγορία αυτή, εµπεριέχεται ο δείκτης 

Schedule Variance (SV) που περιγράφει τη διακύµανση του χρονοδιαγράµµατος 

του έργου, ο δείκτης Cost Variance (CV) που περιγράφει τη διακύµανση του 

κόστους του έργου και ο δείκτης Variance at Completion (VAC) που περιγράφει 

την τελική διακύµανση του έργου. 

• ∆είκτες (Indices): H κατηγορία αυτή εµπεριέχει το δείκτη Schedule 

Performance Index (SPI) που εκφράζει το πόσο αποτελεσµατικά δαπανάται ο 

διαθέσιµος χρόνος του έργου, το δείκτη Cost Performance Index (CPI) που 

εκφράζει το πόσο αποτελεσµατικά δαπανούνται οι διαθέσιµοι πόροι του έργου 

και το δείκτη To-Complete Performance Index (TCPI) που εκφράζει το πόσο 
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DATA BAC ACWP BCWP BCWS

VARIANCES VAC CV SV

INDICES TCPI CPI SPI

FORECASTS EAC

VAC = BAC-EAC CV = BCWP-ACWP SV = BCWP-BCWS
TCPI = (BAC-BCWP)/(BAC-ACWP) CPI = BCWP/ACWP SPI = BCWP/BCWS

EAC = BAC/CPI

αποτελεσµατικά θα πρέπει να χρησιµοποιηθούν οι εναποµείναντες διαθέσιµοι 

πόροι. 

• Προβλέψεις (Forecasts): Στην κατηγορία αυτή, εµπεριέχεται ο δείκτης Time 

Estimate at Completion (TEAC) που υποδεικνύει την πιθανή ηµεροµηνία 

ολοκλήρωσης του έργου, ο δείκτης Estimate at Completion (EAC) που 

υποδεικνύει το πιθανό ολικό κόστους του έργου και ο δείκτης Estimate to 

Complete (ETC) που υποδεικνύει το πιθανό κόστος των εργασιών που 

αποµένουν για την ολοκλήρωση του έργου. 

Ο πίνακας που ακολουθεί, παρουσιάζει συνοπτικά όλα τα ανωτέρω παραγόµενα 

µεγέθη της µεθόδου της «∆εδουλευµένης Αξίας» καθώς και τον µαθηµατικό τύπο από τον 

οποίο προκύπτουν. 

 

 

 

 

 

Πίνακας 9 – Παραγόµενα Μεγέθη Μεθόδου «∆εδουλευµένης Αξίας» 

 

Ανάλογα µε τις τιµές που παίρνουν τα ανωτέρω παραγόµενα µεγέθη, εξάγονται και 

αντίστοιχα συµπεράσµατα σχετικά µε την πορεία του έργου. Στον πίνακα που ακολουθεί, 

παρουσιάζεται συνοπτικά τα πορίσµατα για την πορεία του έργου ανάλογα µε τις πιθανές 

τιµές των παραγόµενων µεγεθών. 
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Πίνακας 10 – Ερµηνεία Βασικών Μεγεθών Μεθόδου «∆εδουλευµένης Αξίας» 

 

3.2 Ανάλυση των παραγόµενων µεγεθών της µεθόδου της «∆εδουλευµένης Αξίας» 

 

3.2.1 Schedule Variance (SV) 

Ο δείκτης Schedule Variance καθορίζει εάν το υπό εξέταση έργο είναι 

καθυστερηµένο ή όχι σε σχέση µε το συµφωνηθέν χρονοδιάγραµµα. Η τιµή του δείκτη 

υπολογίζεται µε αφαίρεση της τιµής του Προϋπολογισθέν Κόστους (Planned Value ή 

BCWS) από την τιµή της ∆εδουλευµένης Αξίας (Earned Value ή BCWP). Θετικό πρόσηµο 

υποδεικνύει ευνοϊκή κατάσταση για το έργο ενώ αρνητική τιµή υποδεικνύει ότι το έργο 

είναι καθυστερηµένο. Για το παράδειγµα που µελετάµε, ο δείκτης Schedule Variance 

ισούται µε: 

Schedule Variance (SV) = BCWP – BCWS = 26 – 34 = - 8 

Ο δείκτης Schedule Variance µπορεί να εκφραστεί και σαν ποσοστό επί τοις 

εκατό, αν διαιρεθεί µε την τιµή του Προϋπολογισθέν Κόστους, συγκεκριµένα:  

Schedule Variance % (SV %) = SV / BCWS = - 8 / 34 = - 23,53 % 

Από τα ανωτέρω, εξάγεται το συµπέρασµα ότι το έργο είναι κατά 23,53 % 

καθυστερηµένο σε αρχικό χρονοδιάγραµµα ή µε άλλα λόγια το 23,53 % της 

προκαθορισµένης εργασίας του έργου δεν έχει ακόµη εκτελεσθεί. 
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3.2.2 Cost Variance (CV)  

Ο δείκτης Cost Variance καθορίζει εάν το υπό εξέταση έργο υπερβαίνει ή όχι 

τον αρχικό προϋπολογισµό. Η τιµή του δείκτη υπολογίζεται µε αφαίρεση της τιµής του 

Πραγµατικού Κόστους (ACWP) από την τιµή της ∆εδουλευµένης Αξίας (BCWP). 

Αντίστοιχα µε το δείκτη Schedule Variance, θετικό πρόσηµο του δείκτη δηλώνει ευνοϊκή 

κατάσταση για το έργο. Για το παράδειγµα που µελετάµε, ο δείκτης Cost Variance ισούται 

µε:  

Cost Variance (CV) = BCWP – ACWP = 26 – 36 = - 10 

Ο δείκτης Cost Variance µπορεί επίσης να εκφραστεί σαν ποσοστό επί τοις 

εκατό, αν διαιρεθεί µε την τιµή της ∆εδουλευµένης Αξίας, συγκεκριµένα:  

Cost Variance % (CV %) = CV / BCWP = - 10 / 26 = - 38,46 % 

Από τα ανωτέρω, συµπεραίνουµε ότι το έργο υπερβαίνει κατά 38,46% τον 

αρχικό προϋπολογισµό. 

 

3.2.3 Schedule Performance Index (SPI)  

Ο δείκτης Schedule Performance Index καθορίζει το πόσο αποτελεσµατικά 

δαπανάται ο διαθέσιµος χρόνος του έργου. Η τιµή του δείκτη υπολογίζεται από το πηλίκο 

της τιµής της ∆εδουλευµένης Αξίας (BCWP) προς την τιµή του Προϋπολογισθέν Κόστους 

(BCWS). Αποτέλεσµα µεγαλύτερο του 1 υποδηλώνει ευνοϊκή κατάσταση για το έργο, ενώ 

τιµή µικρότερη του 1 σηµαίνει ότι το έργο είναι καθυστερηµένο. Συγκεκριµένα:  

Schedule Performance Index = BCWP / BCWS = 26 / 34 = 0,76 

Η ανωτέρω τιµή φανερώνει ότι ο διαθέσιµος χρόνος του έργου, δαπανάται σε 

ποσοστό µόλις 76,47% αποτελεσµατικά.  
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3.2.4 Cost Performance Index (CPI)  

Ο δείκτης Cost Performance Index καθορίζει το πόσο αποτελεσµατικά 

χρησιµοποιούνται οι διαθέσιµοι πόροι του έργου. Η τιµή του δείκτη υπολογίζεται από το 

πηλίκο της τιµής της ∆εδουλευµένης Αξίας (BCWP) προς την τιµή του Πραγµατικού 

Κόστους (ACWP). Αποτέλεσµα µεγαλύτερο του 1 υποδηλώνει ευνοϊκή κατάσταση για το 

έργο, ενώ τιµή µικρότερη του 1 σηµαίνει ότι το έργο είναι υπερκοστολογηµένο. 

Συγκεκριµένα:  

Cost Performance Index = BCWP / ACWP = 26 / 36 = 0,72 

Η ανωτέρω τιµή φανερώνει ότι οι διαθέσιµοι πόροι του έργου, δαπανώνται σε 

ποσοστό 72,72 % αποτελεσµατικά.  

 

3.2.5 Estimate at Completion (EAC)  

Ο δείκτης Estimate at Completion παρέχει το πιθανό ολικό κόστος του έργου αν 

υποτεθεί ότι θα συνεχιστεί και στο µέλλον η παρούσα απόδοση. Για τον υπολογισµό του 

EAC θα πρέπει να διαιρέσουµε την τιµή του δείκτη BAC (Budget at Completion) προς την 

τιµή του δείκτη CPI (Cost Performance Index). Για το παράδειγµα που µελετάµε θα ισχύει:  

Estimate at Completion (EAC) = BAC / CPI = 64 / 0,72 = 88,88 

 

3.2.6 Variance at Completion (VAC)  

Ο δείκτης Variance at Completion φανερώνει εάν το υπό εξέταση έργο θα 

ολοκληρωθεί υπερκοστολογηµένο ή όχι σε σχέση µε τον αρχικό προϋπολογισµό. Για τον 

υπολογισµό του VAC απαιτείται η αφαίρεση της τιµής του δείκτη EAC από την τιµή του 

δείκτη BAC. Στο παράδειγµα που µελετάµε, ισχύει:  

Variance at Completion (VAC) = BAC - EAC = 64 – 88,88 = - 24,88 
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Η ανωτέρω τιµή φανερώνει ότι το έργο θα ολοκληρωθεί πάνω από τον αρχικό 

προϋπολογισµό και συγκεκριµένα απαιτείται επιπλέον ποσό 24,88 για την ολοκλήρωση. 

 

3.2.7 To-Complete Performance Index (TCPI)  

Ένας εξίσου πολύ σηµαντικός δείκτης είναι ο To-Complete Performance Index 

που υποδηλώνει την απόδοση που θα πρέπει να επιτευχθεί για την εργασία που αποµένει 

για την ολοκλήρωση του έργου, ώστε να επιτευχθεί ένα συγκεκριµένο αποτέλεσµα, όπως 

το Budget at Completion (BAC). Στο παράδειγµα που µελετάµε, ο δείκτης TCPI ισούται 

µε:  

To-Complete Performance Index (TCPI) = (BAC – BCWP) / (BAC – ACWP) = 1,36 

Το ανωτέρω αποτέλεσµα φανερώνει ότι για την επίτευξη του BAC, θα πρέπει 

να βελτιωθεί η απόδοση του έργου από το 0,72 που βρίσκεται τώρα σε 1,36 για την 

εναποµένουσα εργασία µέχρι την ολοκλήρωση του έργου. 

  

3.2.8 Time Estimation at Completion (TEAC)  

Χρησιµοποιώντας το δείκτη Schedule Performance Index (SPI) και τη µέση 

τιµή του Προϋπολογισθέν Κόστους (BCWS), µπορούµε να υπολογίσουµε έναν άλλο πολύ 

σηµαντικό δείκτη που ονοµάζεται Time Estimation at Completion. Ο δείκτης TEAC δίνει 

µια εκτίµηση του ολικού χρόνου που απαιτείται για την ολοκλήρωση του έργου. Για το υπό 

µελέτη παράδειγµα ο δείκτης TEAC διαµορφώνεται ως εξής: 

Time Estimation at Completion (TEAC) = (BAC/SPI) / (BAC/days) = 

= (64/0,76) / (64/12) = 15,78 

Η αρχική εκτίµηση ολοκλήρωσης του έργου µε βάση το χρονοδιάγραµµα ήταν 

12 ηµέρες. Από το αποτέλεσµα του δείκτη TEAC προκύπτει ότι εάν ακολουθηθεί η 
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παρούσα απόδοση, το έργο θα ολοκληρωθεί σε 15,78 ηµέρες, δηλαδή απαιτούνται 3,78 

ηµέρες επιπλέον. Στο σηµείο αυτό θα πρέπει να αναφερθεί ότι ο δείκτης αυτός, παρέχει µια 

πολύ γενική εκτίµηση του χρόνου ολοκλήρωσης του έργου, δεδοµένου ότι µπορεί να 

υπάρχει µια µη εµφανή απόκλιση από το χρονοδιάγραµµα που να µην αντικατοπτρίζεται 

από τον ανωτέρω δείκτη.  

  

3.2.9 Estimate to Complete (ETC)  

Η ανάλυση των παραγόµενων δεικτών της µεθόδου της ∆εδουλευµένης Αξίας, 

ολοκληρώνεται µε το δείκτη Estimate to Complete (ETC). Ο δείκτης αυτός φανερώνει το 

κόστος που απαιτείται για την ολοκλήρωση των εργασιών που αποµένουν. Η τιµή του 

δείκτη ETC για το παράδειγµα που µελετάµε προκύπτει από τη ακόλουθη σχέση:  

Estimate to Complete (ETC) = (BAC – BCWP) / CPI = (64 – 26) / 0,72 = 52,77 

Από τα ανωτέρω, συµπεραίνουµε ότι το ολικό κόστος των εργασιών που 

αποµένουν για την ολοκλήρωση του έργου ισούται µε 52,77 εάν υποθέσουµε η απόδοση 

του έργου θα παραµείνει ως έχει. 
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Κεφάλαιο 4ο – Ενηµέρωση χρονοδιαγράµµατος και παρακολούθηση 
εξέλιξης έργου. 
 

4.1 Εισαγωγικά στοιχεία 

Αφού ολοκληρώσαµε στο πρώτο µέρος την παρουσίαση της µεθόδου της 

«∆εδουλευµένης Αξίας» και µελετήσαµε τους παραγόµενους δείκτες αυτής, στο δεύτερο 

µέρος θα εµβαθύνουµε στη διαδικασία ενηµέρωσης του χρονοδιαγράµµατος του έργου και 

την παρακολούθηση της εξέλιξης του. Το λογισµικό που θα χρησιµοποιήσουµε, είναι το 

Microsoft Project και ειδικότερα, η έκδοση 2003.  

Σε γενικές γραµµές, όταν διαχειριζόµαστε ένα έργο, τα βήµατα που θα πρέπει να 

ακολουθήσουµε για να ενηµερώσουµε το χρονοδιάγραµµα του και να παρακολουθήσουµε 

την πορεία του συνοψίζονται ως εξής: 

• Θέσπιση της βάσης µέτρησης της αποτελεσµατικότητας του έργου, 

performance measurement baseline (PMB) και διατήρησή της όσο το δυνατόν 

πιο ανέπαφη κατά τη διάρκεια του έργου. 

• Καθορισµός του βέλτιστου αριθµού αναφορών της πορείας του έργου. 

• Επιλογή στρατηγικής ενηµέρωσης του χρονοδιαγράµµατος του έργου. 

o Στρατηγική ενηµέρωσης δραστηριοτήτων έργου. 

o Στρατηγική ενηµέρωσης αντιστοιχίσεων έργου (συνδυασµός δραστηριότητας 

και πόρων). 

• Ενηµέρωση του χρονοδιαγράµµατος του έργου. 

• Προετοιµασία και παρουσίαση αναφοράς 
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4.2 Θέσπιση της βάσης µέτρησης της αποτελεσµατικότητας του έργου (baseline). 

Η βάση µέτρησης της αποτελεσµατικότητας ενός έργου, αποτελεί µια αυστηρά 

παγιωµένη εικόνα του εγκεκριµένου χρονοδιαγράµµατος του έργου, η οποία θα πρέπει να 

παραµένει όσο το δυνατόν πιο αµετάβλητη κατά τη διάρκειά του. Σε γενικές γραµµές, η 

θέσπισή της, πραγµατοποιείται µόνο µια φορά εκτός αν συντρέχουν οι κατωτέρω λόγοι, 

οπότε απαιτείται τροποποίησή της. 

• Έγκριση αλλαγών που σχετίζονται µε προσθήκες ή αφαιρέσεις παραδοτέων, 

επιµέρους δραστηριοτήτων ή διαθέσιµων πόρων του έργου. 

• Έκτακτες περιστάσεις, όπως πυρκαγιές, απεργίες, οικονοµικές κρίσεις που 

επηρεάζουν το έργο και την πορεία του. 

• Έκτακτα καιρικά φαινόµενα που επηρεάζουν το έργο, όπως πληµµύρες, 

σεισµικές δονήσεις, τυφώνες, κλπ. 

Σε όλες τις ανωτέρω περιπτώσεις, πριν την τροποποίηση της βάσης µέτρησης της 

αποτελεσµατικότητας, απαιτείται έγγραφη αίτηση µεταβολής από την οµάδα διαχείρισης 

του έργου και έγκριση της από τους µετόχους. 

Για να αποθηκεύσουµε τη βάση µέτρησης της αποτελεσµατικότητας ενός έργου, 

αφού ολοκληρώσαµε το χρονοδιάγραµµα και αντιστοιχίσαµε τους πόρους µε τη βοήθεια 

του λογισµικού Microsoft Project 2003, ακολουθούµε τα εξής βήµατα: 

• Επιλογή Tools → Tracking → Save Baseline 

• Επιλογή ◙ Save Baseline 

o Επιλογή ◙ Entire Project, αν επιθυµούµαι να συµπεριλάβουµε το 

σύνολο των δραστηριοτήτων του έργου. 
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o Επιλογή ◙ Selected Tasks, αν επιθυµούµαι να συµπεριλάβουµε ένα 

µέρος των δραστηριοτήτων του έργου. 

 

4.3 Καθορισµός του βέλτιστου αριθµού αναφορών της πορείας του έργου. 

Σε γενικές γραµµές, ο διαχειριστής του έργου δεν επιθυµεί την προετοιµασία 

πολλών αναφορών, αφού αυτό απαιτεί δαπάνη πολύτιµου χρόνου και επιπλέον κόστους. 

Από την άλλη µεριά, η προετοιµασία λίγων αναφορών δεν αποκαλύπτει εγκαίρως πιθανά 

προβλήµατα µε αποτέλεσµα να ελλοχεύει ο κίνδυνος να διολισθήσει το χρονοδιάγραµµα 

και να το έργο να βγει εκτός ελέγχου. 

Για τη σωστή παρακολούθηση ενός έργου, απαιτείται η προετοιµασία δέκα 

τουλάχιστον αναφορών προόδου, ώστε να διασφαλιστεί η δυνατότητα ανάληψης 

διορθωτικών µέτρων όπου αυτό απαιτείται. Στον πίνακα που παρατίθεται, εµφανίζεται η 

βέλτιστη περίοδος αναφορών ανάλογα µε χρονική διάρκεια του έργου. 

∆ιάρκεια Έργου Περίοδος Αναφορών 

Ένας Μήνας Ανά δύο ηµέρες  

Τρεις Μήνες Κάθε εβδοµάδα 

Ένα Έτος Μηνιαία 

∆ύο Έτη Ανά δύο µήνες 

Πέντε Έτη Ανά εξάµηνο 
Πίνακας 11 – Περίοδος Αναφορών Ανάλογα µε τη ∆ιάρκεια του Έργου 

 

4.4 Επιλογή στρατηγικής ενηµέρωσης του χρονοδιαγράµµατος του έργου. 

Όπως έχει αναφερθεί ανωτέρω, υπάρχουν δύο στρατηγικές ενηµέρωσης του 

χρονοδιαγράµµατος ενός έργου: η στρατηγική ενηµέρωση των δραστηριοτήτων και η 

στρατηγική ενηµέρωσης των αντιστοιχίσεων (συνδυασµός δραστηριοτήτων και πόρων).  
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 Πραγµατικός χρόνος έναρξης
 Πραγµατική διάρκεια
 Εκτιµώµενη αποµένουσα διάρκεια
 Πραγµατικός χρόνος λήξης

 για κάθε δραστηριότητα ξεχωριστά

Ενηµέρωση 
∆ραστηριοτήτων

 Πραγµατικές ώρες
 Αποµένουσες ώρες

 για κάθε έναν πόρο
 ανά ηµέρα ή εβδοµάδα
 για κάθε µια αντιστοίχιση

Αυτόµατη Ενηµέρωση 
Αντιστοιχίσεων από MS Project

Αυτόµατη Ενηµέρωση 
∆ραστηριοτήτων από MS Project

Ενηµέρωση 
Αντιστοιχίσεων

Εάν επιλεγεί η στρατηγική ενηµέρωσης των δραστηριοτήτων, θα πρέπει να 

εισαχθούν στο λογισµικό Microsoft Project 2003, τα κατωτέρω δεδοµένα για κάθε µια 

δραστηριότητα ξεχωριστά: 

• Πραγµατικός χρόνος έναρξης δραστηριότητας 

• Πραγµατική διάρκεια δραστηριότητας 

• Εκτιµώµενη αποµένουσα διάρκεια δραστηριότητας 

• Πραγµατικός χρόνος λήξης δραστηριότητας 

Εάν επιλεγεί η στρατηγική ενηµέρωσης των αντιστοιχίσεων, θα πρέπει να 

εισαχθούν στο λογισµικό, τα εξής για κάθε έναν πόρο ξεχωριστά: 

• Πραγµατικές ώρες ανά ηµέρα ή ανά εβδοµάδα 

• Αποµένουσες ώρες για κάθε µια αντιστοίχιση ξεχωριστά 

Ο πίνακας που παρατίθεται, συνοψίζει τις δύο εναλλακτικές στρατηγικές 

ενηµέρωσης του χρονοδιαγράµµατος ενός έργου. Εάν επιλέξουµε να ενηµερώνουµε τις 

δραστηριότητες του έργου, το λογισµικό Microsoft Project 2003 αυτόµατα ενηµερώνει τις 

αντιστοιχίσεις αυτού και αντιστρόφως. 

 

 
 
 
 
 
 
 
 
 
 
 

Πίνακας 12 – Παρουσίαση Στρατηγικών Ενηµέρωσης Χρονοδιαγράµµατος Έργου 
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Η διαδικασία ενηµέρωσης των δραστηριοτήτων του έργου είναι σαφώς ευκολότερη 

και ταχύτερη διαδικασία σε σχέση µε τη διαδικασία ενηµέρωσης των αντιστοιχίσεων που 

απαιτεί συλλογή πολλών δεδοµένων και κατ’ επέκταση καταβολή επιπλέον εργασίας από 

την πλευρά της οµάδας διαχείρισης του έργου. Συγκεκριµένα, έχει παρατηρηθεί ότι η 

διαδικασία ενηµέρωσης των αντιστοιχίσεων απαιτεί τέσσερις φορές επιπλέον εργασία σε 

σύγκριση µε τη διαδικασία ενηµέρωσης των δραστηριοτήτων. Από την άλλη µεριά, η 

διαδικασία ενηµέρωσης των αντιστοιχίσεων είναι πολύ πιο ακριβείς και οδηγεί σε 

ασφαλέστερα συµπεράσµατα αναφορικά µε την πορεία του έργου. Λόγω του εξαιρετικά 

µεγάλου φόρτου εργασίας που περιγράφεται ανωτέρω, έχει παρατηρηθεί σε πολλά έργα, η 

οµάδα διαχείρισης να σταµατά να ενηµερώνει το χρονοδιάγραµµα, είτε λόγω του ότι 

αποτυγχάνει να συγκεντρώσει όλα τα απαραίτητα δεδοµένα είτε αποτυγχάνει να 

διαχειριστεί εγκαίρως όλη την πληροφορία που έχει συλλέξει. Αυτό, βέβαια, έχει ως 

συνέπεια την απώλεια του ελέγχου της πορείας του έργου και µπορεί να αποδειχθεί 

καταστροφικό για την περαιτέρω εξέλιξή του.  

Συνοψίζοντας τα ανωτέρω, αντιλαµβάνεται κανείς πόσο σηµαντική κρίνεται η 

επιλογή της κατάλληλης στρατηγικής ενηµέρωσης του χρονοδιαγράµµατος ενός έργου από 

την οµάδα διαχείρισης αυτού. Στις παραγράφους που ακολουθούν, επιχειρείται η 

παρουσίαση των δύο εναλλακτικών στρατηγικών ενηµέρωσης µε τη βοήθεια του 

λογισµικού MS Project 2003.  

 

4.4.1 ∆ιαδικασία ενηµέρωσης δραστηριοτήτων έργου 

Η διαδικασία ενηµέρωσης των δραστηριοτήτων ενός έργου περιλαµβάνει τα 

κατωτέρω στάδια: 
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• Συλλογή δεδοµένων (πραγµατική και εκτιµώµενη αποµένουσα διάρκεια 

δραστηριοτήτων). 

• Επιλογές κατάλληλων ρυθµίσεων στο λογισµικό MS Project 2003. 

• Προετοιµασία οθονών λογισµικού για τη διαδικασία ενηµέρωσης. 

• Καθορισµός πεδίων Status Date και Current Date. 

• Καθορισµός του τύπου (Type) των προς ενηµέρωση δραστηριοτήτων. 

• ∆ιαδικασία ενηµέρωσης δραστηριοτήτων. 

 

4.4.1.1 Συλλογή δεδοµένων (πραγµατική και εκτιµώµενη αποµένουσα διάρκεια 

δραστηριοτήτων) 

Για να ενηµερώσουµε το χρονοδιάγραµµα ενός έργου, θα πρέπει πρώτα να 

συλλέξουµε τα απαραίτητα δεδοµένα από την οµάδα διαχείρισης του. Ο συνηθέστερος 

τρόπος συλλογής, είναι η χρησιµοποίηση των κατωτέρω ερωτήσεων: 

• Ποια ηµέρα ξεκίνησε η συγκεκριµένη δραστηριότητα; (πραγµατική έναρξη) 

• Πόσες ηµέρες πραγµατικής εργασίας έχουν δαπανηθεί µέχρι και την ηµέρα 

αξιολόγησης του έργου; (πραγµατική διάρκεια) 

• Πόσες ηµέρες εργασίας απαιτούνται από την ηµέρα αξιολόγησης του έργου 

και µετά για να ολοκληρωθεί η δραστηριότητα; (εκτιµώµενη αποµένουσα 

διάρκεια) 

• Ποια ηµέρα ολοκληρώθηκε η συγκεκριµένη δραστηριότητα; (πραγµατική 

λήξη). 
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Η συλλογή των ανωτέρω δεδοµένων µπορεί να πραγµατοποιηθεί µε δύο 

διαφορετικές µεθόδους και έγκειται στον υπεύθυνο διαχείρισης του έργου για το ποια από 

τις δύο θα επιλεγεί τελικά. 

• Τακτικές συναντήσεις προόδου 

Σε συναντήσεις διάρκειας το πολύ µιας ώρας, ο υπεύθυνος διαχείρισης του 

έργου, θέτει προς όλα τα µέλη της οµάδας τις ανωτέρω ερωτήσεις και είτε 

ενηµερώνει το χρονοδιάγραµµα εκείνη τη στιγµή είτε µετά το πέρας της 

συνάντησης. 

• ∆ιανοµή ειδικών εντύπων συµπλήρωσης προόδου 

Ο υπεύθυνος διαχείρισης του έργου, συντάσσει και διανέµει σε όλα τα µέλη 

της οµάδας ένα ειδικό έντυπο που περιέχει τις ανωτέρω ερωτήσεις και 

κατάλληλα πεδία συµπλήρωσης. Στη συνέχεια συλλέγει τα συµπληρωµένα 

έντυπα και ενηµερώνει το χρονοδιάγραµµα του έργου βάσει των 

απαντήσεων που έχουν δοθεί. 

 

4.4.1.2 Επιλογές κατάλληλων ρυθµίσεων στο λογισµικό MS Project 2003. 

Για να λειτουργήσει η διαδικασία ενηµέρωσης του χρονοδιαγράµµατος 

ενός έργου µέσω της ενηµέρωσης των δραστηριοτήτων αυτού, θα πρέπει πρώτα να γίνουν 

ορισµένες ρυθµίσεις στο λογισµικό MS Project 2003. Στον ακόλουθο πίνακα, 

παρουσιάζεται το σύνολο των απαιτούµενων ρυθµίσεων: 

Επιλογή Tools → Option 

Πεδίο Επιλογή 
Calculation ◙ Update task status updates resource status. 

Με την επιλογή αυτή, κάθε φορά που ενηµερώνεται µια δραστηριότητα, αυτόµατα το 
λογισµικό ενηµερώνει και τις αντιστοιχίσεις της συγκεκριµένης δραστηριότητας. Στην 
περίπτωση που ο υπεύθυνος του έργου επιλέξει να ενηµερώνει τόσο τις δραστηριότητες 
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όσο και τις αντιστοιχίσεις, η επιλογή αυτή πρέπει να παραµείνει ανενεργή. 
◙ Move end of completed parts after status date back to status date. 
Με την επιλογή αυτή, το λογισµικό µεταφέρει αυτόµατα το κοµµάτι της ολοκληρωµένης 
διάρκειας κάθε δραστηριότητας πριν την ηµεροµηνία αξιολόγησης. 

◙ And move end of remaining parts before status date back to status date. 
Με την επιλογή αυτή, το λογισµικό µεταφέρει το κοµµάτι της αποµένουσας 
διάρκειας κάθε δραστηριότητας στην ηµεροµηνία αξιολόγησης. 

 ◙ Move start of remaining parts before status date forward to status date. 
Με την επιλογή αυτή, το λογισµικό µεταφέρει αυτόµατα την αρχή κάθε αποµένουσας 
διάρκειας δραστηριότητας στην ηµεροµηνία αξιολόγησης. 

◙ And move end of completed parts forward to status date. 
Με την επιλογή αυτή, το λογισµικό µεταφέρει το πέρας κάθε δραστηριότητας στην 
ηµεροµηνία αξιολόγησης. 

◘ Edits to total task % complete will be spread to the status date. 
Με την επιλογή αυτή, εάν µια δραστηριότητα έχει καθυστερήσει, η % πρόοδος που θα 
εισαχθεί στο λογισµικό, θα επιµηκύνει τη διάρκεια της δραστηριότητας µέχρι και την 
ηµεροµηνία αξιολόγησης. 
◙ Actual costs are always calculated by Microsoft Project. 
Με την επιλογή αυτή, κάθε φορά που ενηµερώνεται µια δραστηριότητα, το λογισµικό 
ενηµερώνει αυτόµατα το συναρτούµενο στη δραστηριότητα πραγµατικό κόστος.  

Με την επιλογή αυτή, το λογισµικό Microsoft Project 2003, θέτει τις 
ανωτέρω επιλογές ως προκαθορισµένες για όλα τα νέα έργα. 

General ◘ Automatically add new resources and tasks. 
Η επιλογή αυτή, εµποδίζει την αυτόµατη εισαγωγή νέων δραστηριοτήτων ή πόρων από 
πιθανά τυπογραφικά λάθη. 

Edit ◘ Allow cell drag and drop. 
Η επιλογή αυτή, εµποδίζει την αυτόµατη αντιγραφή δεδοµένων πάνω σε άλλα δεδοµένα 
από «σύρσιµο» του «ποντικιού». 
◙ Split in-progress tasks. 
Η επιλογή αυτή, επιτρέπει την αυτόµατη µετακίνηση των ατελείωτων κοµµατιών κάθε 
δραστηριότητας µετά την ηµεροµηνία αξιολόγησης. Αυτό επιτυγχάνεται µε διάσπαση 
της δραστηριότητας. 

Schedule 

Με την επιλογή αυτή, το λογισµικό Microsoft Project 2003, θέτει τις 
ανωτέρω επιλογές ως προκαθορισµένες για όλα τα νέα έργα. 

Πίνακας 13 – Ρυθµίσεις λογισµικού MS Project για την ενηµέρωση των δραστηριοτήτων 

 

4.4.1.3 Προετοιµασία οθονών λογισµικού για τη διαδικασία ενηµέρωσης. 

Η οθόνη Tracking View του λογισµικού Microsoft Project 2003 επιτρέπει 

στον υπεύθυνο διαχείρισης ενός έργου να ενηµερώνει εύκολα και γρήγορα την πρόοδο των 

δραστηριοτήτων του. Για να εµφανιστεί η συγκεκριµένη οθόνη θα πρέπει να ακολουθηθεί 

η εξής διαδικασία: 

• Επιλογή View → Table <………….> → Tracking 
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Παράλληλα το λογισµικό διαθέτει και τη µπάρα εργαλείων Tracking, η 

οποία διαθέτει κατάλληλα κουµπιά για την άµεση ενηµέρωση της πορείας των 

δραστηριοτήτων του έργου. Η συγκεκριµένη µπάρα εργαλείων µπορεί να εµφανιστεί µε 

τον εξής τρόπο: 

• Επιλογή View → Toolbars → Tracking 

Στην εικόνα που παρατίθεται, παρουσιάζεται η εικόνα του λογισµικού 

µετά την εφαρµογή των ανωτέρω ρυθµίσεων. 

Πίνακας 14 – Οθόνη Tracking View του λογισµικού MS Project 2003 

 

4.4.1.4 Καθορισµός πεδίων Status Date και Current Date. 

Για να καθοριστούν οι δύο κρίσιµες µεταβλητές Status Date και Current 

Date θα πρέπει να ακολουθηθεί η εξής διαδικασία: 

• Επιλογή Project → Project Information 
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Στο πεδίο Status Date του αναδυόµενου παραθύρου που εµφανίζεται, ο 

υπεύθυνος διαχείρισης του έργου θέτει την ηµεροµηνία που επιθυµεί να ενηµερώσει τις 

δραστηριότητες του έργου.  

Στο πεδίο Current Date, ο υπεύθυνος διαχείρισης του έργου, θα πρέπει να 

επιλέξει την ίδια ηµεροµηνία µε αυτή που έθεσε στο πεδίο Status Date. Αµέσως στην 

οθόνη εµφανίζεται µια κάθετη γραµµή που υποδηλώνει την ηµεροµηνία αξιολόγησης. 

 

4.4.1.5 Καθορισµός του τύπου (Type) των προς ενηµέρωση δραστηριοτήτων. 

Κάθε φορά που εισάγονται νέα δεδοµένα στο λογισµικό MS Project 2003, 

προκαλείται ένας επαναυπολογισµός όλων των δεδοµένων βάσει της κατωτέρω σχέσης:  

∆ιάρκεια · Αριθµός Αντιστοιχισµένων Πόρων = Εργασία 

Η ακρίβεια των υπολογισµών που πραγµατοποιεί το λογισµικό βασίζεται 

στον επιλεγµένο τύπο των δραστηριοτήτων (task type). Πιο συγκεκριµένα, κάθε φορά που 

ο υπεύθυνος διαχείρισης ενός έργου ενηµερώνει τις δραστηριότητες αυτού, τροποποιεί τη 

διάρκεια τους. Ως εκ τούτου ο τύπος Fixed Duration δεν αποτελεί την κατάλληλη επιλογή. 

Από την άλλη µεριά, όταν επεκτείνεται η διάρκεια µιας δραστηριότητας 

και επιθυµούµε να κρατήσουµε σταθερούς τους πόρους που έχουν αντιστοιχηθεί στη 

συγκεκριµένη δραστηριότητα, η καταλληλότερη επιλογή είναι Fixed Units. Αντίστοιχα, αν 

επιθυµούµε θα αυξήσουµε τους πόρους τότε θα πρέπει να επιλέξουµε Fixed Work.  

Για να καθορίσουµε τον επιθυµητό τύπο µιας δραστηριότητας ενός έργου 

ακολουθούµε την εξής διαδικασία: 

• Επιλογή Task Information → Advanced 

Στο πεδίο Task Type επιλέγουµε Fixed Units και ξεµαρκάρουµε την 

επιλογή Effort Driven. 



ΜΠΣ Logistics                                                                                                                  Earned Value Project Management 

Γεώργιος Π. Παπαδόπουλος                                                                                                             Page 33 of 61 

Ηµεροµηνία
Ανάλυσης 

4.4.1.6 ∆ιαδικασία ενηµέρωσης δραστηριοτήτων. 

Κατά την προσπάθεια ενηµέρωσης των δραστηριοτήτων ενός έργου, ο 

υπεύθυνος διαχείρισης αυτού, έρχεται αντιµέτωπος µε τις έξι κατωτέρω διαφορετικές 

καταστάσεις. 

• ∆ραστηριότητες που εξελίχθηκαν σύµφωνα µε το αρχικό χρονοδιάγραµµα. 

Πρόκειται για την πιο απλή περίπτωση που µπορεί να 

αντιµετωπίσει ο υπεύθυνος διαχείρισης ενός έργου. Για την 

ενηµέρωση αυτών των δραστηριοτήτων απαιτείται µόνο η 

εισαγωγή του ποσοστού 100% στο πεδίο % Complete του λογισµικού Microsoft Project 

2003. 

• ∆ραστηριότητες που εξελίσσονται σύµφωνα µε το αρχικό χρονοδιάγραµµα. 

Στην περίπτωση αυτή, ο υπεύθυνος διαχείρισης του έργου θα 

πρέπει να δείξει ότι η πορεία της δραστηριότητας εξελίσσεται 

όπως είχε αρχικά σχεδιαστεί. Για την ενηµέρωση αυτών των 

δραστηριοτήτων απαιτείται η επιλογή Update as Schedule από τη µπάρα εργαλείων 

Tracking. 

• ∆ραστηριότητες που καθυστερούν  σε σχέση µε το αρχικό χρονοδιάγραµµα. 

Η περίπτωση αυτή απαιτεί µεγαλύτερη προσπάθεια από τον 

υπεύθυνο διαχείρισης του έργου. Από τη µια µεριά θα πρέπει 

να απεικονιστεί η πραγµατική πρόοδος της δραστηριότητας 

και από την άλλη θα πρέπει µετακινηθεί το κοµµάτι της 

ανολοκλήρωτης δραστηριότητας µετά την ηµεροµηνία ανάλυσης. Για την ενηµέρωση των 

συγκεκριµένων δραστηριοτήτων απαιτείται η εξής διαδικασία. Αρχικά, θα πρέπει να 

Ηµεροµηνία
Ανάλυσης 

Ηµεροµηνία
Ανάλυσης 
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Ηµεροµηνία
Ανάλυσης 

εισαχθεί στο λογισµικό η πραγµατική πρόοδος της δραστηριότητας στο πεδίο Actual 

Duration (πραγµατικές ηµέρες εργασίας) και συνέχεια θα πρέπει να εισαχθεί η εκτιµώµενη 

αποµένουσα διάρκεια της δραστηριότητας στο πεδίο Remaining Duration. Το λογισµικό 

MS Project 2003 υπολογίζει αυτόµατα το % ποσοστό ολοκλήρωσης της δραστηριότητας 

και το απεικονίζει στο πεδίο % Complete. Εξαιτίας των ρυθµίσεων Split in-progress tasks 

και Move start of remaining parts before status date forward to status date που έχουν 

επιλεχθεί αρχικά, το λογισµικό ανασχεδιάζει αυτόµατα την αποµένουσα εργασία των 

δραστηριοτήτων αυτών µετά την ηµεροµηνία ανάλυσης, όπως φαίνεται στην ανωτέρω 

εικόνα.  

• ∆ραστηριότητες που θα διαρκέσουν περισσότερο (ή λιγότερο). 

Στην περίπτωση αυτή, οι δραστηριότητες έχουν εξελιχθεί βάση 

του αρχικού χρονοδιαγράµµατος, όµως η διάρκεια που αρχικά 

είχε υπολογιστεί δεν ανταποκρίνεται στην πραγµατικότητα, 

οπότε θα πρέπει είτε να αυξηθεί είτε να µειωθεί. Για την 

ενηµέρωση των συγκεκριµένων δραστηριοτήτων απαιτείται η εξής διαδικασία. Αρχικά θα 

πρέπει να διαπιστωθεί ότι ο τύπος των δραστηριοτήτων έχει καθοριστεί σε Fixed Units ή 

Fixed Work. Στη συνέχεια θα πρέπει να εισαχθεί στο λογισµικό η πραγµατική πρόοδος της 

δραστηριότητας στο πεδίο Actual Duration και µετέπειτα η εκτιµώµενη αποµένουσα 

διάρκεια της δραστηριότητας στο πεδίο Remaining Duration.  

• ∆ραστηριότητες που ξεκίνησαν αργότερα (ή νωρίτερα). 

Στην περίπτωση αυτή, η δραστηριότητα δεν ξεκίνησε την 

ηµέρα που είχε αρχικά προγραµµατιστεί να εκκινήσει. Αν ο 

υπεύθυνος διαχείρισης του έργου ενηµερώνει σε τακτά 

Ηµεροµηνία
Ανάλυσης 
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χρονικά διαστήµατα το χρονοδιάγραµµα, το λογισµικό MS Project 2003 αυτόµατα θα έχει 

προσδιορίσει την πραγµατική ηµεροµηνία έναρξης της δραστηριότητας και θα έχει ήδη 

µετατοπίσει τη δραστηριότητα στο διάγραµµα Gantt. Για την ενηµέρωση αυτών των 

δραστηριοτήτων θα πρέπει να εισαχθεί στο λογισµικό η πραγµατική ηµεροµηνία έναρξης 

στο πεδίο Actual Start. 

• ∆ραστηριότητες που ολοκληρώθηκαν αργότερα (ή νωρίτερα. 

Στην περίπτωση αυτή, ο υπεύθυνος διαχείρισης του έργου, 

καλείται να εισάγει την πραγµατική ηµεροµηνία έναρξης της 

δραστηριότητας. Οµοίως µε ανωτέρω, αν το χρονοδιάγραµµα 

ενηµερώνεται σε τακτά χρονικά διαστήµατα, το λογισµικό 

MS Project 2003, θα έχει αυτόµατα υπολογίσει την πραγµατική ηµεροµηνία περάτωσης 

της δραστηριότητας και θα την εµφανίζει στο πεδίο Actual Finish. Σε περίπτωση που δεν 

συµβαίνει κάτι τέτοιο, ο υπεύθυνος διαχείρισης του έργου, καλείται να εισάγει αυτός την 

πραγµατική ηµεροµηνία περάτωσης στο λογισµικό και συγκεκριµένα στο πεδίο Actual 

Finish.  

 

4.4.2 ∆ιαδικασία ενηµέρωσης αντιστοιχίσεων έργου (συνδυασµός δραστηριότητας 

και πόρων).  

Η διαδικασία ενηµέρωσης των αντιστοιχίσεων ενός έργου (συνδυασµός 

δραστηριοτήτων και πόρων) περιλαµβάνει τα εξής κατωτέρω στάδια: 

• Επιλογή των δεδοµένων που θα πρέπει να συλλέγονται. 

• Επιλογές κατάλληλων ρυθµίσεων στο λογισµικό MS Project 2003. 

• Προετοιµασία οθονών λογισµικού για τη διαδικασία ενηµέρωσης. 
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• Καθορισµός πεδίων Status Date και Current Date. 

• Καθορισµός του τύπου (Type) των προς ενηµέρωση αντιστοιχίσεων. 

• ∆ιαδικασία ενηµέρωσης αντιστοιχίσεων. 

 

4.4.2.1 Επιλογή των δεδοµένων που θα πρέπει να συλλέγονται 

Ο υπεύθυνος διαχείρισης του έργου θα πρέπει να αποφασίσει τι είδους 

δεδοµένα θα πρέπει να συλλεχθούν ώστε να ενηµερώσει τις αντιστοιχίσεις του έργου και 

κατ’ επέκταση το χρονοδιάγραµµα αυτού. Στις παραγράφους που ακολουθούν, επιχειρείται 

η παρουσίαση των δεδοµένων που είναι δυνατόν να συλλεχθούν. 

• Ποσοστό ολοκληρωµένης εργασίας 

Πρόκειται για την πιο απλή µορφή δεδοµένων που µπορεί να συλλεχθεί. 

Για κάθε µια αντιστοίχιση απαιτείται να προσδιοριστεί το ποσοστό της ολοκληρωµένης 

εργασίας. Κατά γενική οµολογία, το ποσοστό ολοκληρωµένης εργασίας, αποτελεί ένα πολύ 

αδύναµο µέτρο αξιολόγησης και για το λόγο αυτό δε συνίσταται ως επιλογή. 

• Σύνολο πραγµατικής εργασίας που επιτεύχθηκε και αποµένουσα εργασία 

ανά δραστηριότητα 

Η επιλογή αυτή, έχει το πλεονέκτηµα ότι απαιτεί ελάχιστη προσπάθεια για 

καταχώρηση δεδοµένων. Συγκεκριµένα, απαιτούνται µόνο δύο καταχωρήσεις για κάθε µία 

αντιστοίχιση. Το µειονέκτηµα της µεθόδου είναι ότι οι δύο αυτοί αριθµοί θα πρέπει να 

υπολογίζονται από µνήµης. Για παράδειγµα, έστω ότι στο λογισµικό MS Project 2003 είναι 

καταχωρηµένος ο αριθµός 12 που αντιπροσωπεύει τις πραγµατικές ώρες εργασίας της 

προηγούµενης εβδοµάδας και έστω ότι οι συνολικές ώρες εργασίας για την τρέχουσα 

εβδοµάδα είναι 14. Ο υπεύθυνος διαχείρισης του έργου θα πρέπει να εισάγει στο λογισµικό 
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τον αριθµό 26 ( = 12 + 14). Αυτή η διαδικασία, δυσκολεύει πολλές φορές τον υπεύθυνο 

διαχείρισης του έργου µε αποτέλεσµα να πραγµατοποιούνται εύκολα λάθη. 

• Σύνολο ωρών εργασίας που επιτεύχθηκε ανά ηµέρα /εβδοµάδα και σύνολο 

ωρών αποµένουσας εργασίας 

Πρόκειται για την πιο ακριβείς µέθοδο ενηµέρωσης των αντιστοιχίσεων 

ενός έργου. Ο υπεύθυνος διαχείρισης συλλέγει τις πραγµατικές ώρες εργασίας κάθε µιας 

αντιστοίχισης ανά ηµέρα µια φορά την εβδοµάδα µε τη βοήθεια κατάλληλων εντύπων. Από 

τα επιµέρους δεδοµένα που συλλέγονται, µέσω του λογισµικού υπολογίζεται η συνολική 

εργασία που έχει δαπανηθεί και κατ’ επέκταση η πραγµατική αποµένουσα εργασία για την 

ολοκλήρωση της δραστηριότητας. Παρόλο που η µέθοδος αυτή, απαιτεί την καταβολή 

µεγάλης προσπάθειας από την οµάδα διαχείρισης ενός έργου, συνίσταται ανεπιφύλαχτα 

εξαιτίας της ακρίβειάς της και των ασφαλών συµπερασµάτων που οδηγεί. Για το λόγο αυτό 

θα επικεντρωθούµε στην ανάλυση της διαδικασίας ενηµέρωσης των αντιστοιχίσεων ενός 

έργου µε τη βοήθεια της ανωτέρω µεθόδου. 

 

4.4.2.2 Επιλογές κατάλληλων ρυθµίσεων στο λογισµικό MS Project 2003 

Για να λειτουργήσει η διαδικασία ενηµέρωσης του χρονοδιαγράµµατος 

ενός έργου µέσω της ενηµέρωσης των αντιστοιχίσεων αυτού, θα πρέπει πρώτα να γίνουν 

ορισµένες ρυθµίσεις στο λογισµικό MS Project 2003. Στον ακόλουθο πίνακα, 

παρουσιάζεται το σύνολο των απαιτούµενων ρυθµίσεων: 

Επιλογή Tools → Option 

 

Πεδίο Επιλογή 
Calculation ◙ Update task status updates resource status. 

Με την επιλογή αυτή, το λογισµικό MS Project 2003 υπολογίζει αυτόµατα το ποσοστό 
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ολοκλήρωσης των δραστηριοτήτων του έργου όταν πραγµατοποιείται ενηµέρωση των  
αντιστοιχίσεων αυτού. 
◘ Move end of completed parts after status date back to status date. 
Με την επιλογή αυτή, το λογισµικό µεταφέρει αυτόµατα το κοµµάτι της ολοκληρωµένης 
διάρκειας κάθε δραστηριότητας πριν την ηµεροµηνία αξιολόγησης. Η ρύθµιση αυτή, δεν 
θα πρέπει επιλεγεί όταν πραγµατοποιείται ενηµέρωση των αντιστοιχίσεων ενός έργου. 

◘ And move end of remaining parts before status date back to status date. 
Με την επιλογή αυτή, το λογισµικό µεταφέρει το κοµµάτι της αποµένουσας διάρκειας 
κάθε δραστηριότητας στην ηµεροµηνία αξιολόγησης. Η ρύθµιση αυτή, επίσης δεν θα 
πρέπει επιλεγεί όταν πραγµατοποιείται ενηµέρωση των αντιστοιχίσεων ενός έργου. 
 ◘ Move start of remaining parts before status date forward to status date. 
Με την επιλογή αυτή, το λογισµικό µεταφέρει αυτόµατα την αρχή κάθε αποµένουσας 
διάρκειας δραστηριότητας στην ηµεροµηνία αξιολόγησης. Η ρύθµιση αυτή, δεν θα 
πρέπει επιλεγεί όταν πραγµατοποιείται ενηµέρωση των αντιστοιχίσεων ενός έργου. 

◘ And move end of completed parts forward to status date. 
Με την επιλογή αυτή, το λογισµικό µεταφέρει το πέρας κάθε δραστηριότητας στην 
ηµεροµηνία αξιολόγησης. Η ρύθµιση αυτή, επίσης δεν θα πρέπει επιλεγεί όταν 
πραγµατοποιείται ενηµέρωση των αντιστοιχίσεων ενός έργου. 

◙ Actual costs are always calculated by Microsoft Project. 
Με την επιλογή αυτή, κάθε φορά που ενηµερώνεται µια αντιστοίχιση, το λογισµικό 
ενηµερώνει αυτόµατα το συναρτούµενο σ’ αυτήν πραγµατικό κόστος. 

General ◘ Automatically add new resources and tasks. 
Η επιλογή αυτή, εµποδίζει την αυτόµατη εισαγωγή νέων δραστηριοτήτων ή πόρων από 
πιθανά τυπογραφικά λάθη. 

Edit ◘ Allow cell drag and drop. 
Η επιλογή αυτή, εµποδίζει την αυτόµατη αντιγραφή δεδοµένων πάνω σε άλλα δεδοµένα 
από «σύρσιµο» του «ποντικιού». 
◙ Split in-progress tasks. 
Η επιλογή αυτή, επιτρέπει την αυτόµατη µετακίνηση των ατελείωτων κοµµατιών κάθε 
δραστηριότητας µετά την ηµεροµηνία αξιολόγησης. Αυτό επιτυγχάνεται µε διάσπαση 
της δραστηριότητας. 

Schedule 

◘ Autolink inserted or moved tasks. 
Η επιλογή αυτή, αποτρέπει τις αλλαγές του δικτύου του έργου από τυπογραφικά λάθη. 

Πίνακας 15 – Ρυθµίσεις λογισµικού MS Project για την ενηµέρωση των αντιστοιχίσεων 

 

4.4.2.3 Προετοιµασία οθονών λογισµικού για τη διαδικασία ενηµέρωσης. 

Η οθόνη Resource Usage του λογισµικού Microsoft Project 2003 

επιτρέπει στον υπεύθυνο διαχείρισης ενός έργου να ενηµερώνει εύκολα και γρήγορα την 

πρόοδο των αντιστοιχίσεων του. Για να εµφανιστεί η συγκεκριµένη οθόνη θα πρέπει να 

ακολουθηθεί η εξής διαδικασία: 

• Επιλογή View → Resource Usage 

• Επιλογή View → Table <………….> → More Tables 

• Επιλογή του πίνακα Work και επιλογή Copy 



ΜΠΣ Logistics                                                                                                                  Earned Value Project Management 

Γεώργιος Π. Παπαδόπουλος                                                                                                             Page 39 of 61 

• Μετονοµασία του πίνακα σε Update Assignments 

• Εισαγωγή των πεδίων Baseline Work, Work, Actual Work, Remaining 

Work και % Work Complete κάτω από το πεδίο Name 

• Επιλογή Detail Styles . . . 

• Εισαγωγή των πεδίων Baseline Work και Actual Work 

Ακολουθώντας τις ανωτέρω οδηγίες, το λογισµικό εµφανίζει την πιο 

κατάλληλη οθόνη για ενηµέρωση των αντιστοιχίσεων ενός έργου, που επιτρέπει γρήγορη 

και εύκολη καταχώρηση δεδοµένων. 

 

4.4.2.4 Καθορισµός πεδίων Status Date και Current Date. 

Για να καθοριστούν οι δύο κρίσιµες µεταβλητές Status Date και Current 

Date θα πρέπει να ακολουθηθεί η εξής διαδικασία: 

• Επιλογή Project → Project Information 

Στο πεδίο Status Date του αναδυόµενου παραθύρου που εµφανίζεται, ο 

υπεύθυνος διαχείρισης του έργου θέτει την ηµεροµηνία που επιθυµεί να ενηµερώσει τις 

αντιστοιχίσεις του έργου. Στο πεδίο Current Date, ο υπεύθυνος διαχείρισης του έργου, θα 

πρέπει να επιλέξει την ίδια ηµεροµηνία µε αυτή που έθεσε στο πεδίο Status Date.  

 

4.4.2.5 Καθορισµός του τύπου (Type) των προς ενηµέρωση αντιστοιχίσεων. 

Ο υπεύθυνος διαχείρισης ενός έργου, οφείλει να προσδιορίσει τον τύπο 

των δραστηριοτήτων κατά τέτοιον τρόπο που να επιτυγχάνονται ακριβείς υπολογισµοί από 

το λογισµικό Ms Project 2003. Πιο συγκεκριµένα, όταν επιλεγεί η διαδικασία ενηµέρωση 

των αντιστοιχίσεων ο τύπος Fixed Work δεν αποτελεί καλή επιλογή για τις δραστηριότητες 
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του έργου, αφού το λογισµικό δεν µπορεί να «διακρίνει» τι ακριβώς πρέπει να υπολογίσει. 

Σε αντιστοιχία µε τη διαδικασία ενηµέρωσης των δραστηριοτήτων, έτσι και στη διαδικασία 

ενηµέρωσης των αντιστοιχίσεων, η επιλογή Fixed Units αποτελεί την πλέον κατάλληλη 

επιλογή για τον τύπο των δραστηριοτήτων.  

Για να µετατραπεί ο τύπος των δραστηριοτήτων του έργου σε Fixed Units 

θα πρέπει να ακολουθηθεί η κατωτέρω διαδικασία. 

• Επιλογή View → Tracking Gantt 

• Επιλογή όλων των δραστηριοτήτων → Task Information → Advanced 

• Στο πεδίο Task Type θέτουµε Fixed Units και ξεµαρκάρουµε την επιλογή 

Effort Driven. 

 

4.4.2.6 ∆ιαδικασία ενηµέρωσης αντιστοιχίσεων. 

Σε πλήρη αντιστοιχία µε τη διαδικασία ενηµέρωσης των δραστηριοτήτων 

έτσι και στη διαδικασία ενηµέρωσης των αντιστοιχίσεων, ο υπεύθυνος διαχείρισης του 

έργου, έρχεται αντιµέτωπος µε τις έξι κατωτέρω διαφορετικές καταστάσεις. 

• Αντιστοιχίσεις που εξελίχθηκαν σύµφωνα µε το αρχικό χρονοδιάγραµµα. 

Πρόκειται για την πιο απλή από τις έξι περιπτώσεις που µπορεί να έρθει 

αντιµέτωπος ο υπεύθυνος διαχείρισης ενός έργου. Για να ενηµερώσει τις συγκεκριµένες 

αντιστοιχίσεις, θα πρέπει να τις επιλέξει και να θέσει στο πεδίο % Work Complete της 

διαµορφωµένης οθόνης Resource Usage το ποσοστό 100%. Προσοχή, δεν θα πρέπει να 

χρησιµοποιηθεί το κουµπί  από τη µπάρα εργαλείων Tracking του λογισµικού MS 

Project 2003, γιατί αυτό χρησιµοποιείται αποκλειστικά για ενηµέρωση δραστηριοτήτων 

και όχι για ενηµέρωση αντιστοιχίσεων. 
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• Αντιστοιχίσεις που εξελίσσονται σύµφωνα µε το αρχικό χρονοδιάγραµµα. 

Για την ενηµέρωση των συγκεκριµένων αντιστοιχίσεων, ο υπεύθυνος 

διαχείρισης του έργου, θα πρέπει να εισάγει στο πεδίο Actual Work της οθόνης Resource 

Usage του λογισµικού MS Project 2003, τον αριθµό των πραγµατικών ωρών που 

δαπανήθηκαν για τη συγκεκριµένη εργασία µέχρι και την ηµεροµηνία ανάλυσης (Status 

Date). Ο αριθµός των πραγµατικών ωρών θα πρέπει να ταυτίζεται µε τον αριθµό των ωρών 

που αρχικά είχε προϋπολογιστεί και εµφανίζεται στο πεδίο Baseline Work. Για εύκολη 

εισαγωγή δεδοµένων µπορεί να χρησιµοποιηθεί η λειτουργία dragging µέσω της οποίας 

επιτυγχάνεται ταχεία αντιγραφή των δεδοµένων ενός κελιού στα υπόλοιπα. 

• Αντιστοιχίσεις που καθυστερούν  σε σχέση µε το αρχικό χρονοδιάγραµµα. 

Πρόκειται για σαφώς πιο περίπλοκη περίπτωση σε σύγκριση µε τις δύο 

περιπτώσεις που περιγράφηκαν ανωτέρω. Ο υπεύθυνος διαχείρισης του έργου, θα πρέπει 

να εισάγει στο πεδίο Actual Work της οθόνης Resource Usage, τις πραγµατικές ώρες που 

αναλώθηκαν για τη συγκεκριµένη εργασία. Στην πλειονότητα των περιπτώσεων, είναι 

απόλυτα φυσικό οι ώρες που αναγράφονται στα πεδία Actual Work και Baseline Work να 

µην ταυτίζονται. Παράλληλα, η ανολοκλήρωτη εργασία θα πρέπει να ανασχεδιαστεί µετά 

την ηµεροµηνία ανάλυσης (Status Date). Για να πραγµατοποιηθεί αυτό, θα πρέπει να 

επιλεγούν όλες οι καταχωρήσεις του πεδίου Work για τις οποίες δεν υπήρξε πραγµατική 

εργασία και να πατηθεί το κουµπί Insert. Μέσω της ανωτέρω διαδικασίας, το σύνολο της 

ανολοκλήρωτης εργασίας θα µετατοπιστεί και ανασχεδιαστεί µετά την ηµεροµηνία 

ανάλυσης (Status Date). 
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• Αντιστοιχίσεις που θα διαρκέσουν περισσότερο (ή λιγότερο). 

Για τις αντιστοιχίσεις αυτής της κατηγορίας θα πρέπει να γίνει αναπροσαρµογή 

των ωρών που εµφανίζονται στο πεδίο Work της οθόνης Resource Usage. Συγκεκριµένα ο 

υπεύθυνος διαχείρισης του έργου θα πρέπει να προσθέσει στο πεδίο Work και µετά την 

ηµεροµηνία ανάλυσης (Status Date) τις επιπλέον ώρες που απαιτούνται για την περάτωση 

της συγκεκριµένης διαδικασίας. Στις περίπτωση που η επιµήκυνση επιφέρει επιπτώσεις 

στην καθορισµένη διάρκεια της δραστηριότητας, το λογισµικό MS Project 2003, αυτόµατα 

θα ενηµερώσει τον υπεύθυνο διαχείρισης του έργου µέσω αναδυόµενου µηνύµατος. 

• Αντιστοιχίσεις που ξεκίνησαν αργότερα (ή νωρίτερα). 

Για την ενηµέρωση των συγκεκριµένων αντιστοιχίσεων, το µόνο που απαιτείται 

είναι να θέσει ο υπεύθυνος διαχείρισης του έργου την πραγµατική ηµεροµηνία εκκίνησης 

στο πεδίο Actual Work της οθόνης Resource Usage. Αυτόµατα, το λογισµικό MS Project 

2003, αναπροσαρµόζει κατάλληλα την εργασία ώστε να ανταποκρίνεται στα νέα δεδοµένα.  

Η περαιτέρω διαδικασία ενηµέρωσης της αντιστοίχισης, ταυτίζεται µε όσα 

έχουν αναφερθεί ανωτέρω. 

• Αντιστοιχίσεις που ολοκληρώθηκαν αργότερα (ή νωρίτερα). 

Για την ενηµέρωση των αντιστοιχίσεων αυτών, ο υπεύθυνος διαχείρισης του 

έργου, οφείλει να ακολουθήσει την εξής διαδικασία. Θα πρέπει να εισάγει τις πραγµατικές 

ώρες εργασίας στο πεδίο Actual Work της οθόνης Resource Usage µέχρι την ηµεροµηνία 

που ο πόρος ολοκλήρωσε την εργασία που του είχε ανατεθεί. 

 

4.5 Προετοιµασία αναφοράς κατάστασης έργου και πρόβλεψη εξέλιξης. 
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Ανεξάρτητα µε τη διαδικασία ενηµέρωσης του χρονοδιαγράµµατος ενός έργου 

(ενηµέρωση δραστηριοτήτων ή ενηµέρωση αντιστοιχίσεων), η διαδικασία προετοιµασίας 

της αναφοράς προόδου του έργου είναι κοινή και στις δύο περιπτώσεις. Συγκεκριµένα, το 

διάγραµµα Tracking Gantt του λογισµικού MS Project 2003 αποτελεί την πλέον βέλτιστη 

επιλογή για την παρουσίαση της προόδου του έργου. Για να εµφανιστεί η συγκεκριµένη 

οθόνη στο λογισµικό, θα πρέπει να ακολουθηθούν τα εξής βήµατα: 

• Επιλογή View → Tracking Gantt 



ΜΠΣ Logistics                                                                                                                  Earned Value Project Management 

Γεώργιος Π. Παπαδόπουλος                                                                                                             Page 44 of 61 

Κεφάλαιο 5ο – Case Study: Μελέτη – Κατασκευή επέκτασης εργοστασίου 
(Μάνδρα Αττικής). 
 

5.1 Εισαγωγικά στοιχεία 

Ολοκληρώνοντας την παρουσίαση της µεθόδου της «∆εδουλευµένης Αξίας», θα 

εµβαθύνουµε σε ένα πραγµατικό παράδειγµα ώστε να γίνει απόλυτα κατανοητή η 

συγκεκριµένη µεθοδολογία. Συγκεκριµένα θα µελετήσουµε ένα πραγµατικό παράδειγµα 

που αφορά τη µελέτη και κατασκευή επέκτασης ενός εργοστασίου στη Μάνδρα Αττικής. 

Τα στοιχεία του έργου, έχουν προέλθει από την κατασκευάστρια τεχνική εταιρεία 

«Ε∆ΡΑΣΗ – Χ. ΨΑΛΛΙ∆ΑΣ ΑΕ» που εδρεύει στο Κορωπί Αττικής.  

 

5.2 ∆ραστηριότητες έργου 

Το έργο έχει συνολική διάρκεια 241 ηµέρες µε ηµεροµηνία έναρξης στις 30 

Νοεµβρίου 2005 και ηµεροµηνία λήξης στις 16 Αυγούστου 2006. Απαρτίζεται από 99 

δραστηριότητες συνολικά και απαιτεί τον άψογο συντονισµό 74 πόρων προκειµένου να 

επιτευχθεί το επιθυµητό χρονοδιάγραµµα. Το ολικό προϋπολογισθέν κόστος του έργου 

ανέρχεται στις 361.694,00€. Επεµβάσεις θα πραγµατοποιηθούν σε όλα σχεδόν τα τµήµατα 

του υφιστάµενου εργοστασίου. Συγκεκριµένα, εργασίες θα γίνουν στο κτίριο γραφείων, 

στο κτίριο αποθήκης – επεξεργασίας µετάλλου, στο µεταλλικό υπόστεγο και στον 

περιβάλλων χώρο του εργοστασίου.  

Στους ακόλουθους πίνακες, παρουσιάζονται οι επιµέρους δραστηριότητες που 

συνθέτουν το σύνολο των εργασιών που θα εκτελεστούν στα αντίστοιχα τµήµατα του 

εργοστασίου. 
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Κτίριο Γραφείων 
Εκσκαφές θεµελίων κτιρίου γραφείων 
Καθαιρέσεις κτιρίου γραφείων 

Χωµατουργικά 

Επιχώσεις κτιρίου γραφείων 
Θεµελίωση κτιρίου γραφείων 
Σκελετός ισογείου κτιρίου γραφείων 

Σκυροδέµατα 

Σκελετός ορόφου κτιρίου γραφείων 
Εξωτερικές τοιχοποιίες κτιρίου γραφείων Τοιχοποιίες 
Εσωτερικές τοιχοποιίες κτιρίου γραφείου 
Επιχρίσµατα κτιρίου γραφείων 
∆άπεδα γραφείων 
Κουφώµατα γραφείων 
Χρωµατισµοί γραφείων 
Εµφανής τοιχοποιία γραφείων 
Ψευδοροφές γραφείων 

Αρχιτεκτονικά 
Τελειώµατα 

Μονώσεις δώµατος κτιρίου γραφείων 
Πίνακας 16 – ∆ραστηριότητες έργου που αφορούν το κτίριο γραφείων 

 

Μεταλλικό Υπόστεγο 
Εκσκαφές θεµελίων κτιρίου αποθήκης Χωµατουργικά 
Επίχωση 3Α δαπέδου κτιρίου αποθήκης 
Σκυροδέτηση θεµελίων κτιρίου αποθήκης Σκυροδέµατα 
Παραγωγή προκατασκευασµένων στοιχείων κτιρίου αποθήκης 
Ανέγερση υποστηλωµάτων µεταλλικού υποστέγου 
Σύνθεση σκελετού στέγης µεταλλικού υποστέγου 
Ανέγερση στέγης µεταλλικού υποστέγου 

Ανέγερση µεταλλικής 
κατασκευής 

Επικαλύψεις µεταλλικού υποστέγου 
Θύρες µεταλλικού υποστέγου Αρχιτεκτονικά Τελειώµατα 
Χρωµατισµοί µεταλλικού υποστέγου 

Πίνακας 17 – ∆ραστηριότητες έργου που αφορούν το µεταλλικό υπόστεγο 

 

Περιβάλλων Χώρος 
Εκσκαφές- Επιχώσεις ΠΧ ∆ιαµόρφωση 
Γενικές εκσκαφές 
Φρεάτια οµβρίων ΠΧ 
Κράσπεδα ΠΧ 

Οδοστρωσία 

∆ιάστρωση 3Α ΠΧ 
Ασφαλτόστρωση Α260 ΠΧ Οδοποιία 
Ασφαλτόστρωση Α265 ΠΧ 

Πίνακας 18 – ∆ραστηριότητες έργου που αφορούν τον περιβάλλων χώρο 
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Κτίριο Αποθήκης - Επεξεργασίας Μετάλλου 
Εκσκαφές θεµελίων κτιρίου αποθήκης 
Επιχώσεις - ∆ιαµόρφωση δαπέδου  κτιρίου αποθήκης 

Χωµατουργικά 

Επίχωση 3Α δαπέδου κτιρίου αποθήκης 
Σκυροδέτηση θεµελίων κτιρίου αποθήκης 
Τοποθέτηση προκατασκευασµένων υποστηλωµάτων κτιρίου αποθήκης 
Τοποθέτηση προκατασκευασµένων τοιχείων κτιρίου αποθήκης 
Τοποθέτηση γερανοδοκών υδρορροών κτιρίου αποθήκης 
Τοποθέτηση ζευκτών κτιρίου αποθήκης 
Τοποθέτηση πλακών κτιρίου αποθήκης 
Σκυροδετήσεις συνδέσεων κτιρίου αποθήκης 

Σκυροδέµατα 

Παραγωγή προκατασκευασµένων στοιχείων κτιρίου αποθήκης 
Θερµοµόνωση - Στεγάνωση στέγης κτιρίου αποθήκης 
Σφράγιση αρµών κτιρίου αποθήκης 
Κουφώµατα κτιρίου αποθήκης 

Αρχιτεκτονικά 
Τελειώµατα 

Χρωµατισµοί κτιρίου αποθήκης 
Πίνακας 19 – ∆ραστηριότητες έργου που αφορούν το κτίριο αποθήκης – επεξεργασίας µετάλλου 

 

Πέραν των ανωτέρω κύριων δραστηριοτήτων του έργου, υπάρχουν δραστηριότητες 

που αφορούν τη γενικότερη εγκατάσταση του εργοταξίου στο χώρο του εργοστασίου και 

περιλαµβάνουν την τοποθέτηση εργοταξιακών γραφείων, τις συνδέσεις µε τα δίκτυα ΟΚΩ 

(οργανισµοί κοινής ωφέλειας) και την κατασκευή νέων περιφράξεων. 

Για την έγκαιρη ολοκλήρωση των ανωτέρω δραστηριοτήτων, είναι απαραίτητη η 

χρήση σηµαντικών πόρων τόσο υλικών όσο και ανθρώπινων. Στην ακόλουθη παράγραφο, 

επιχειρείται µια σύντοµη παρουσίαση όλων των χρησιµοποιούµενων πόρων του έργου. 

 

5.3 Πόροι έργου 

Όπως έχει αναφερθεί ανωτέρω, το έργο απαρτίζεται από 99 δραστηριότητες ενώ 74 

πόροι συνδυάζονται για την ολοκλήρωσή του. Συγκεκριµένα πρόκειται για 30 ανθρώπινους 

πόρους (work resources) και 44 υλικούς (material resources). Οι συνολικές εργάσιµες ώρες 

για την ολοκλήρωση του έργου ανέρχονται σε 10.880. Στους πίνακες που ακολουθούν, 

αναφέρονται οι απαιτούµενοι πόροι του έργου. 
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Ανθρώπινοι Πόροι Έργου 
Αδειολόγος Μηχανικός 
Τοπογράφος Μηχανικός 
Εργοταξιάρχης - Μηχανικός Ασφαλείας 
Εργοδηγός - Συντονιστής 
Εργάτης Α 
Εργάτης Β 
Εργάτης Γ 
Εργάτης ∆ 
Εργάτης Ε 
Χειριστής BOBCAT 
Χειριστής Φορτηγού 
Χειριστής Γερανού (Παπαγαλάκι) 
Αδειούχος Ηλεκτρολόγος 
Βοηθός Ηλεκτρολόγου 
Αδειούχος Υδραυλικός 
Βοηθός Υδραυλικού 
Ηλεκτρονικός 
Χειριστής Τσάπας 
Χειριστής Σφυριού 
Χτίστης 
Βοηθός Χτίστη 
Τεχνίτης Τοποθέτησης Πλακιδίων 
Βοηθός Τεχνίτη Τοποθέτησης Πλακιδίων 
Τεχνίτης Τοποθέτησης Αλουµινένιων Κουφωµάτων 
Βοηθός Τεχνίτη Τοποθέτησης Αλουµινένιων Κουφωµάτων 
Βαφέας 
Βοηθός Βαφέα 
Τεχνικός Μόνωσης 
Βοηθός Τεχνικού Μόνωσης 
Χειριστής Τηλεσκοπικού Γερανού 
Χειριστής Κυλίνδρου Ασφαλτόστρωσης 

Πίνακας 20 – Πίνακας Ανθρώπινων Πόρων 

 

Υλικοί Πόροι Έργου 
Σκυρόδεµα Περίφραξης 
Συρµατόπλεγµα Περίφραξης 
Σκυρόδεµα Βάσης Container 
Container ISOBOX 
Σωληνογραµµές και Υλικά ∆ικτύου Νερού 
Σωληνογραµµές και Υλικά ∆ικτύου Οµβρύων 
Υδροροές και Υλικά 
Φρεάτια και Καπάκια Οµβρύων 
Ξυλότυπος Θεµελίωσης Κτιρίου Γραφείων 
Σκυρόδεµα Θεµελίων Κτιρίου Γραφείων 
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Μεταλλικός Σκελετός Ισογείου Κτιρίου Γραφείων 
Μεταλλικός Σκελετός Ορόφου Κτιρίου Γραφείων 
Τσιµέντο Εξωτερικής Τοιχοποιίας 
Τούβλα Εξωτερικής Τοιχοποιίας 
Ψευδοχωρίσµατα Κτιρίου Γραφείων 
Επίχρισµα Κτιρίου Γραφείων 
Πλακάκια ∆απέδου 
Κουφώµατα Αλουµινίου Γραφείων 
Βαφές Γραφείων 
Ψευδοροφές και Φωτιστικά Κτιρίου Γραφείων 
Ασφαλτόπανο και Υλικά Μόνωσης Κτιρίου Γραφείων 
Ξυλότυπος Θεµελίωσης Κτιρίου Αποθήκης 
Σκυρόδεµα Θεµελίων Κτιρίου Αποθήκης 
Προκατασκευασµένα Υποστηλώµατα Κτιρίου Αποθήκης 
Προκατασκευασµένα Τοιχεία Κτιρίου Αποθήκης 
Γερανοδοκοί Υδρορροών Κτιρίου Αποθήκης 
Πλάκες Κτιρίου Αποθήκης 
Σκυρόδεµα Συνδέσεων Κτιρίου Αποθήκης 
Ασφαλτόπανο και Υλικά Μόνωσης Στέγης Κτιρίου Αποθήκης 
Κουφώµατα Αλουµινίου Αποθήκης 
Βαφές Αποθήκης 
Ξυλότυπος Θεµελίωσης Μεταλλικού Υποστέγου 
Σκυρόδεµα Θεµελίων Μεταλλικού Υποστέγου 
Ξυλότυπος Θεµελίωσης Τοιχείων Μεταλλικού Υποστέγου 
Σκυρόδεµα Τοιχείων Μεταλλικού Υποστέγου 
Υποστηλώµατα Μεταλλικού Υποστέγου 
Μεταλλικός Σκελετός Υποστέγου 
Θύρες Μεταλλικού Υποστέγου 
Βαφές Μεταλλικού Υποστέγου 
Φρεάτια Οµβρύων Περιβάλλων Χώρου 
Σκυρόδεµα Κρασπέδων 
Επίχωµα 3Α 
Άσφαλτος Α260 
Άσφαλτος Α265 

Πίνακας 21 – Πίνακας Υλικών Πόρων 

 

5.4 Εισαγωγή δεδοµένων έργου στο λογισµικό MS Project 

Το επόµενο βήµα είναι η εισαγωγή των ανωτέρω στοιχείων στο λογισµικό MS 

Project 2003. Αρχικά εισάγουµε τις δραστηριότητες του έργου και τις εκτιµώµενες 

διάρκειές τους, στο φύλλο «Gantt Chart» του λογισµικού. Στη συνέχεια και στο ίδιο φύλλο, 

καθορίζουµε την αλληλοσυσχέτιση των δραστηριοτήτων και καθορίζουµε τη σειρά των 

εργασιών που πρόκειται να εκτελεσθούν (∆ιάγραµµα 21). Ακολούθως, καταγράφουµε στο 
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φύλλο «Resource Sheet» του λογισµικού, τους πόρους που απαιτούνται για την 

ολοκλήρωση του έργου. Η καταγραφή των πόρων προϋποθέτει και των καθορισµό του 

κόστους που απορρέει από τη χρησιµοποίησή τους (∆ιάγραµµα 22). Μετά την καταγραφή 

όλων των απαιτούµενων πόρων, ακολουθεί η αντιστοίχιση τους µε τις δραστηριότητες του 

έργου. Συγκεκριµένα, στο φύλλο «Gantt Chart» του λογισµικού, αντιστοιχίζουµε σε κάθε 

µια δραστηριότητα, τους πόρους που απαιτούνται για την ολοκλήρωσή της (υλικούς και 

ανθρώπινους). 

∆ιάγραµµα 22 – Οθόνη «Gantt Chart» Λογισµικού MS Project 2003 
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∆ιάγραµµα 23 – Οθόνη «Resource Sheet» Λογισµικού MS Project 2003 

 

Αφού αντιστοιχίσουµε όλους τους πόρους στις αντίστοιχες δραστηριότητες του 

έργου, είµαστε σε θέση να καθορίσουµε τη βάση µέτρησης της αποτελεσµατικότητας. Από 

την επιλογή Tools του λογισµικού MS Project 2003, επιλέγουµε Tracking και Save 

Baseline. Αυτόµατα το λογισµικό αποθηκεύει τη βάση µέτρησης της αποτελεσµατικότητας 

και τη χρησιµοποιεί ως µέτρο σύγκρισης και αξιολόγησης της πορείας του έργου. Το 

επόµενο βήµα είναι η επιλογή της στρατηγικής ενηµέρωσης του χρονοδιαγράµµατος. 
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Επιλέγουµε να χρησιµοποιήσουµε τη στρατηγική ενηµέρωσης των αντιστοιχίσεων, αφού 

συντελεί σε εξαγωγή πληρέστερων και ασφαλέστερων συµπερασµάτων αναφορικά µε την 

εξέλιξη του έργου. Πριν την έναρξη της διαδικασίας ενηµέρωσης, οφείλουµε να 

επιλέξουµε τις κατάλληλες ρυθµίσεις που συµβαδίζουν µε τη συγκεκριµένη στρατηγική και 

να καθορίσουµε τα πεδία Status Date και Current Date. Συγκεκριµένα, από το µενού Tools 

επιλέγουµε Options και µαρκάρουµε όλες τις επιλογές που περιγράφονται αναλυτικά στο 

τέταρτο κεφάλαιο και στις σελίδες 33, 34. Παράλληλα επιλέγουµε όλες τις δραστηριότητες 

του έργου και µε τη βοήθεια του µενού Task Information, καθορίζουµε τον τύπο των 

δραστηριοτήτων σε Fixed Units, ενώ ξεµαρκάρουµε την επιλογή Effort Driven. Τέλος, από 

το µενού Project Information καθορίσουµε τα πεδία Status και Current Date σηµειώνοντας 

την επιθυµητή ηµεροµηνία ανάλυσης (δηλαδή 29/04/2006).  

Αφού ολοκληρώσαµε όλες τις απαραίτητες ρυθµίσεις που απαιτούνταν, είµαστε 

έτοιµοι να εκκινήσουµε τη διαδικασία ενηµέρωσης των αντιστοιχίσεων. Η εισαγωγή των 

δεδοµένων θα γίνει µέσω της οθόνης «Resource Usage» έτσι όπως αναλυτικά περιγράφεται 

στο δεύτερο κεφάλαιο και στις σελίδες 37, 38 και 39. 

Με την ολοκλήρωση της διαδικασίας ενηµέρωσης των αντιστοιχίσεων, είµαστε σε 

θέση να εξάγουµε τα πρώτα συµπεράσµατα για την πορεία του έργου. Από την επιλογή 

Project Summary του µενού Reports, µπορούµε να λάβουµε µια πρώτη συγκεντρωτική 

εικόνα για την πορεία του έργου µέχρι και την ηµεροµηνία ανάλυσης. 

Συγκεκριµένα, παρατηρούµε ότι το έργο έχει ολοκληρωθεί κατά 60%. Συνολικά 

έχουν δαπανηθεί 6.762 ώρες εργασίας ενώ αποµένουν 4.248 για την περάτωση του έργου. 

Από πλευράς κόστους, παρατηρούµε ότι το έργο έχει ήδη απορροφήσει 150.335,00€ ενώ 

θα πρέπει να δαπανηθούν 212.654,00€ επιπλέον για την ολοκλήρωσή του. Από τις 99 

δραστηριότητες του έργου, 37 έχουν ήδη ολοκληρωθεί, 13 είναι σε εξέλιξη και 49 δεν 
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έχουν ξεκινήσει ακόµη. Ο πίνακας που ακολουθεί, παρουσιάζει την περιληπτική αναφορά 

της προόδου του έργου, έτσι όπως παρέχεται από το λογισµικό MS Project 2003.  

Πίνακας 24 – Περιληπτική Αναφορά Προόδου Έργου 

 

Από την οθόνη «Gantt Chart» είµαστε σε θέση να εντοπίσουµε τις δραστηριότητες 

του έργου που έχουν ήδη ολοκληρωθεί. Συγκεκριµένα, το λογισµικό σηµειώνει αυτές τις 

δραστηριότητες µε   ενώ από την επιλογή Current Activities του µενού Reports 

µπορούµε να ανατρέξουµε σε περισσότερες πληροφορίες αναφορικά µε τις συγκεκριµένες 

δραστηριότητες. Ο πίνακας που παρατίθεται, εµπεριέχει όλες τις ολοκληρωµένες 

δραστηριότητες του έργου µέχρι και την ηµεροµηνία ανάλυσης, 29/04/2006. 
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Πίνακας 25 – Πίνακας Ολοκληρωµένων ∆ραστηριοτήτων Έργου 

Πέραν όµως των ανωτέρω συµπερασµάτων και πληροφοριών, το λογισµικó MS 

Project 2003 δύναται να δώσει και όλες τις απαραίτητες τιµές που σχετίζονται µε τα 

βασικά µεγέθη της µεθόδου της «∆εδουλευµένης Αξίας». Στην παράγραφο που ακολουθεί 

παρουσιάζεται η ανάλυση και όλα τα συµπεράσµατα από την εφαρµογή της µεθόδου στο 

έργο που µελετάµε.  

 

5.5 Εφαρµογή της µεθόδου της «∆εδουλευµένης Αξίας» 

Η εφαρµογή της µεθόδου της «∆εδουλευµένης Αξίας» θα αποκαλύψει την 

πραγµατική πορεία του έργου µέχρι και την ηµεροµηνία ανάλυσης. Το λογισµικό MS 

Project παρέχει µέσω της επιλογής Earned Value του µενού Reports τις τιµές των βασικών 

µεγεθών της συγκεκριµένης µεθόδου για κάθε µια δραστηριότητα του έργου (Πίνακας 25). 
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Πίνακας 26 – Βασικά Μεγέθη Μεθόδου ∆εδουλευµένης Αξίας Για Κάθε Μια ∆ραστηριότητα Του Έργου 

 

Αν αθροίσουµε τις επιµέρους τιµές των τριών βασικών δεικτών για κάθε µια από 

τις δραστηριότητες του έργου, θα προκύψουν οι αντίστοιχοι συγκεντρωτικοί δείκτες. Στον 

πίνακα που ακολουθεί αναγράφονται οι συγκεντρωτικοί δείκτες για το σύνολο του έργου 

µέχρι και την ηµεροµηνία ανάλυσης. 
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Τιµές Βασικών Μεγεθών Μεθόδου «∆εδουλευµένης Αξίας» 
Case Study : Μελέτη και Κατασκευή Επέκτασης Εργοστασίου (Μάνδρα Αττικής) 

Προϋπολογισθέν Κόστος Έργου (BCWS) 151.890,00€ 
∆εδουλευµένη Αξία Έργου (BCWP) 148.894,63€ 
Πραγµατικό Κόστος Έργου (ACWP) 150.295,00€ 

Πίνακας 27 – Τιµές Βασικών Μεγεθών Μεθόδου «∆εδουλευµένης Αξίας» 

Έχοντας ως βάση τα ανωτέρω µεγέθη, µπορούµε να προχωρήσουµε στον 

υπολογισµό των παραγόµενων µεγεθών της µεθόδου και να εξάγουµε τα συµπεράσµατά 

µας για την πορεία του έργου. 

 

5.6 Υπολογισµός παραγόµενων µεγεθών µεθόδου «∆εδουλευµένης Αξίας» 

Αρχικά, υπολογίζουµε το δείκτη Schedule Variance (SV) του έργου. Συγκεκριµένα 

θα ισχύει: 

Schedule Variance (SV) = BCWP – BCWS = 148.894,63€ - 151.890,00€ = - 2.995,38€ 

Η αρνητική τιµή του δείκτη, φανερώνει ότι το έργο είναι καθυστερηµένο σε σχέση 

µε το συµφωνηθέν χρονοδιάγραµµα κατά 1,9%.  

Συνεχίζουµε την ανάλυση µε τον υπολογισµό του δείκτη Cost Variance (CV). Η 

τιµή του δείκτη διαµορφώνεται ως εξής: 

Cost Variance (CV) = BCWP – ACWP = 150.295,00€- 151.890,00€ = - 1.400,38€ 

Το αποτέλεσµα φανερώνει ότι το έργο είναι υπερκοστολογηµένο σε σχέση µε το 

συµφωνηθέν προϋπολογισµό κατά 1%. 

Παρόλο που οι αποκλίσεις είναι σχετικά µικρές και δεν δηµιουργούν απαισιοδοξία 

για την πορεία του έργου, δίνουν ένα σαφές µήνυµα στην οµάδα διοίκησης του έργου. 

Στη συνέχεια προχωρούµε στον υπολογισµό των δεικτών Schedule Performance 

Index (SPI) και Cost Performance Index (CPI). Για το παράδειγµα που µελετάµε θα ισχύει: 
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Schedule Performance Index (SPI) = BCWP / BCWS = 148.894,63€ / 151.890,00€ = 0,98 

Cost Performance Index (CPI) = BCWP / ACWP = 148.894,63€ / 150.295,00€ = 0,99 

Από τις ανωτέρω τιµές συµπεραίνουµε ότι αφενός ο διαθέσιµος χρόνος του έργου 

δαπανάται µε αποτελεσµατικότητα 98% και αφετέρου οι διαθέσιµοι πόροι δαπανώνται µε 

αποτελεσµατικότητα 99%.  

Προχωρώντας την ανάλυση, υπολογίζουµε το δείκτη Estimate at Completion (EAC) 

ο οποίος παρέχει το πιθανό τελικό κόστος του έργου µε την προϋπόθεση ότι θα συνεχιστεί 

η ίδια απόδοση.  

Estimate at Completion (EAC) = BAC / CPI = 361.694 / 0,99 = 365.095,78€ 

Η τελική απόκλιση υπολογίζεται σε 3.401,78€ ή 1%. Η τιµή αυτή αντιπροσωπεύει 

το δείκτη Variance at Completion (VAC) και υπολογίζεται µε αφαίρεση της τιµή του EAC 

από την τιµή του BAC. 

Μετέπειτα, υπολογίζουµε δύο επίσης πολύ σηµαντικούς δείκτες αναφορικά µε την 

πορεία του έργου και συγκεκριµένα το δείκτη To-Complete Performance Index (TCPI) και 

το δείκτη Time Estimation at Completion (TEAC). Κάνοντας εφαρµογή των µαθηµατικών 

τύπων προκύπτουν τα εξής αποτελέσµατα: 

To-Complete Performance Index (TCPIBAC) = (BAC – BCWP) / (BAC – ACWP) = 1,0065 

Time Estimation at Completion (TEAC) = (BAC / SPI) / (BAC / days) = 246,5 

Η τιµή του δείκτη (TCPIBAC) φανερώνει την απόδοση που θα πρέπει να επιτευχθεί 

ώστε να περατωθεί το έργο σύµφωνα µε το συµφωνηµένο προϋπολογισµό. Συγκεκριµένα, 

απαιτείται η καταβολή 0,65% επιπλέον προσπάθειας από όλους τους εµπλεκόµενους.  

Η τιµή του δείκτη (TEAC) φανερώνει την πιθανή διάρκεια του έργου αν συνεχιστεί 

η παρούσα απόδοση. Από τους υπολογισµούς προκύπτει ότι το έργο θα ολοκληρωθεί σε 

246,5 ηµέρες, δηλαδή µε υπέρβαση 5,5 ηµερών. 
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Ολοκληρώνουµε την ανάλυση µε τον υπολογισµό του δείκτη Estimate to Complete 

(ETC). Για το παράδειγµα που µελετάµε ισχύει: 

Estimate to Complete (ETC) = (BAC – BCWP) / CPI = 214.800,78€ 

Η ανωτέρω τιµή φανερώνει το ποσό που θα πρέπει να δαπανηθεί για την περάτωση 

του έργου. Το ποσό αυτό είναι 1,5 φορές µεγαλύτερο από το ποσό που έχει δαπανηθεί 

µέχρι στιγµής παρόλο που το έργο έχει ολοκληρωθεί κατά 60%.  

 

5.7 Συµπεράσµατα – Πορίσµατα 

Ολοκληρώνοντας την ανάλυση της πορείας του έργου µε τη βοήθεια της µεθόδου 

της «∆εδουλευµένης Αξίας» καταλήγουµε στα εξής συµπεράσµατα: 

• Το έργο εξελίσσεται οµαλά παρουσιάζοντας µικρή απόκλιση τόσο ως προς το 

συµφωνηθέν χρονοδιάγραµµα όσο και ως προς το συµφωνηθέν προϋπολογισµό. 

Συγκεκριµένα το έργο είναι καθυστερηµένο κατά 2% ενώ είναι και υπερκοστολογηµένο 

κατά 1%. 

• Η οµάδα διοίκησης του έργου, ασκεί µια πολύ ουσιαστική και θετική διοίκηση, 

έχοντας πλήρως τον έλεγχο του έργου. 

• Το χρηµατικό ποσό που πρέπει να δαπανηθεί για την περάτωση του έργου είναι 

1,5 φορές µεγαλύτερο από το ποσό που έχει ήδη καταβληθεί παρόλο που το έργο έχει 

ολοκληρωθεί κατά 60%. Αυτό σηµαίνει ότι ακολουθούν δραστηριότητες του έργου πολύ 

σηµαντικές που απαιτούν την απορρόφηση περισσότερων και σηµαντικοτέρων πόρων. Η 

οµάδα διοίκησης, λοιπόν, οφείλει να συντονίσει τις αποµένουσες δραστηριότητες µε πολύ 

προσοχή ώστε να αποφύγει περαιτέρω διολίσθηση του έργου. 



ΜΠΣ Logistics                                                                                                                  Earned Value Project Management 

Γεώργιος Π. Παπαδόπουλος                                                                                                             Page 58 of 61 

• Σηµαντικό µέρος του ποσού που πρέπει να δαπανηθεί για την περάτωση του 

έργου, προορίζεται για την προµήθεια εξοπλισµού και υλικών. Αυτό σηµαίνει ότι η οµάδα 

διοίκησης του έργου έχει την ευκαιρία να διαπραγµατευτεί µε πιθανούς προµηθευτές για 

εξασφάλιση καλύτερων τιµών από τις προϋπολογισθείσες ώστε να επιτευχθούν 

οικονοµικές ωφέλειες. 
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